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Please Read This Notice 

The program copies provided to you with this documentation are the property of Digital 
Communications Associates, Inc. and are licensed to you, the licensed user of the programs contained 
herein. 

SINGLE USER LICENSE AGREEMENT 

1. LICENSE. DCA grants to you a limited, non-exclusive license to (i) use and display 
the copies of the computer programs contained in this package and any maintenance 
modifications or updates provided to you by DCA ("Programs") on any computer for 
which it is designed so long as you are the only user of the Programs; (ii) install the 
Programs on a file server for your sole and exclusive use; and (iii) make two archival 
copies of each Program for back-up putposes only. You agree not to violate DCA's 
copyright and to affix to the archival copies the copyright notice contained on the 
original disk from which the copies are made. DCA retains all rights to the Programs 
not expressly granted in this Agreement. 

2. OWNERSIDP OF PROGRAMS AND COPIES. The Programs and related 
documentation are copyrighted works of authorship. DCA retains the ownership of 
the Programs and all subsequent copies of the Programs, regardless of the form in 
which the copies may exist. This License is not a sale of the original programs or any 
copies, maintenance modifications or updates. 

3. USE RESTRICTIONS. You may physically or electronically transfer the 
Programs from one computer to another, provided you are the only user of the 
Programs. You agree not to translate, modify, adapt, disassemble, decompile, 
reverse engineer or create derivative works based on the Programs or any portions 
thereof. 

4. TRANSFER. The Programs are licensed only to you, the licensed user of the 
Programs. You may not rent, lease, sublicense, sell, assign, pledge, transfer or 
otherwise dispose of the Programs on a temporary or permanent basis, without the 
prior written consent of DCA. 

5. TERMINA TIONS. This License is effective until terminated. This License will 
terminate automatically without notice from DCA if you fail to comply with any 
provision of this License. Upon termination you must cease all use of the Programs 
and return them, and any copies thereof, to DCA. 

6. GENERAL. This License shall be governed and construed in accordance with the 
laws of the State of Georgia as applied to contracts made and wholly performed 
within the State. 

LIMITED WARRANTIES AND LIMITATION OF LIABILITY 

DCA warrants (i) the media on which the Programs are recorded and the accompanying manuals 
against material defects for a period of ninety (90) days, and (ii) that the Programs will perform 
substantially in accordance with the description in the related manuals for a period of ninety (90) days. 
These warranties commence on the day you first obtain the product and extend only to you, the original 



customer. If (a) DCA determines that a warranted item has been damaged by accident, abuse, misuse or 
misapplication, or has been modified without the written permission of DCA, or (b) any DCA label or 
serial number is removed or defaced, these warranties do not apply and you accept full responsibility 
for the product. These limited warranties give you specific legal rights, and you may have other rights 
which vary from state to state. 

Except as specified above, DCA MAKES NO WARRANTIES OR REPRESENTATIONS, EXPRESS 
OR IMPLIED, REGARDING THE PRODUCT OR ANY PROGRAMS, MEDIA OR MANUALS 
THEREIN, AND EXPRESSLY DISCLAIMS THE WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. DCA does not warrant that the Programs (or any other 
DCA programs contained or used with the product including any maintenance modifications or 
updates) will meet your requirements or that their operation will be uninterrupted or error free. 

If any part of this product is not as warranted above, DCA will, at its option and as your exclusive 
remedy, either (i) repair or replace the nonconforming item at no cost to you, or (ii) refund your money, 
provided you request from DCA a Return Authorization (RA) Number and return the product, with 
proof of the date you obtained it and with the RA Number indicated, to DCA within ten (10) days after 
the expiration of the applicable warranty period. 

THE WARRANTIES AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED. Statements or representations 
which add to, extend or modify the warranties or remedies are unauthorized by DCA and should not be 
called upon by you. 

DCA OR ANYONE INVOLVED IN THE CREATION OR DELIVERY OF THIS PRODUCT TO 
YOU SHALL HAVE NO LIABILITY TO YOU OR ANY THIRD PARTY FOR SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES (including, but not limited to loss of profits, or 
savings, downtime, damage to or replacement of equipment and property or recovery or replacement of 
programs or data) ARISING FROM CLAIMS BASED IN WARRANTY, CONTRACT, TORT 
(including negligence), STRICT TORT, OR OTHERWISE EVEN IF DCA HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH CLAIM OF DAMAGE. DCA'S LIABILITY FOR DIRECT 
DAMAGES SHALL NOT EXCEED THE ACTUAL AMOUNT PAID FOR THE PRODUCT. 

Some states do not allow the exclusion or)imitation of implied warranties or liability for incidental or 
consequential damages, so the above limitations or exclusions may not apply to you. 

U.S. GOVERNMENT RESTRICTED RIGHTS 

The Programs and manuals are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure 
by the Government is subject to restriction as set forth in subdivision (c) (1) (ii) ofthe Rights in 
Technical Data and Computer Software clause at 252.227-7013. Contractor/ manufacturer is Digital 
Communications Associates, Inc./1000 Alderman Drive/Alpharetta, Georgia 30202-4199. 

Should you have questions concerning this Agreement, please contact in writing: DCA Contract 
Administration at the above address. 
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Learn about Irma 

Complete your planning 
checklist 

Install Irma 

Learn about online help 

Configure the connection and 
start a communications session 

Customize your session 

Welcome to 
Irma 
Thank you for buying Irma ™ for 
the Mainframe (referred to as 
Irma). We at DCA ® hope this 
product meets your needs and is 
easy to use. If you have any ideas or 
suggestions, please call us at 
1-800-348-3221. 

We want to hear from you so that 
we can continue to offer the finest 
products available. 

This chapter gives you an overview 
of how this guide is designed. 

How this guide is designed 
The "Task List," shown above, appears on the second page of every chapter, 
showing you the tasks necessary to install, configure, and use Irma. As you 
move through the book, the current task is highlighted, allowing you to track 
your progress and see what lies ahead. 

Why read this guide? 
You need to read this guide to understand the Irma features and the 
connectivity types it offers. This guide also describes the tasks needed to 
install Irma. 

Most of the information that you'll need to configure, customize, and use 
Irma is contained in the online help. This guide teaches you how to use online 
help, and gives you specific topics to reference in the online help. 

You'll find it easier to understand this guide and use Irma if you are familiar 
with Windows and with the type of connectivity you will be using. 

On the next page, the road map shows you how to use this manual. 



Introduction 
You are here. 

Chapter 1 
Learn about the features of Irma. 

f .. •••••••••••••••••••••••••••••••••••• .. C·hapte·r .. 2··· ............ , .. , .................. . 
Read to find out everything you 

need to do before you install Irma. 

Chapter 3 
Follow the instructions to install 

Irma. 

Chapter 4 
Follow the instructions to learn how 

to use online help. 

Chapter 5 
Follow the instructions to configure 

and start a session, and find out 
where to go from here. 

Irma road map 
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Documentation conventions 
The following documentation conventions are used in this guide: 

bold 

italics 

Note 

Caution 

Summary 

In command lines, bold represents information that 
you should enter exactly as shown. 

Italics represent variable information. In command 
lines, do not enter the words themselves in the 
command; enter the information they represent. 

A key name, for example, [Enterl, refers to a specific 
key on the keyboard. 

If you have remapped the function originally 
mapped to the key, substitute the new key or key 
combination for the original. 

This signifies important additional information. 

This signifies that a failure to follow the recom­
mended procedure could result in a loss of data or 
could result in the product not performing properly. 

After reading this chapter, you should know the following: 

o What the Getting Started Guide contains 

o The documentation conventions used in the guide 

o How to get additional information 

In the next chapter, you'll learn more about Irma and the connectivity types it 
offers. 
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Chapter 1 
Learn about Irma 

Complete your planning 
checklist 

Install Irma 

Learn about online help 

Configure the connection and 
start a communications session 

Customize your session 

What is Irma? 

The Task List at left shows the current 
step in the process of installing and using 
Irma. 

In this chapter, you will learn about the 
Irma features and the connectivity options 
you can install. You'll also learn about the 
differences between Irma and previous 
DCA products. You will be introduced to 
the new Irma icons, and you'll learn 
about the file types that Irma uses. 

You'll need about 15 minutes to read this 
chapter. 

Irma for the Mainframe Software for Windows (referred to as Irma) is com­
munications software that allows a PC running Microsoft® Windows™ or 
Windows for Workgroups to communicate directly with other computers 
using a variety of connectivities. 

Irma can connect to a single host, to multiple hosts, or to peer computers 
across an SNA network. 

1-2 WI~&t if! Im1Jl? 



You have two choices when you install the mainframe connectivity: 

• You can install any number of standalone and gateway connection types. 

or 

• You can install one server connection type. 

Examples of the mainframe connection types are shown in Figure 1-1. 

IBMj host m IrmaLAN/EP 
l);! Gateway or 

Digital 
SNA 

ATLANTIS ~ Gateway 
SNA Gateway 0 

/ 
~ IrmaLAN for i ~G~~ay 

~o ~ Wo HP-UX 
SNA 

..0 
_ ~ Server 

802.2 or TCP/IP % ~~, ~ 

~~\ ~I 
dj// ~~ / ~ 
W1~'C~:J ~~, Irma 

? ~ o,ofl connectivity 
IBM c\l 
host / Netway 

/sOle ~ 
Microsoft Q Q i ~ 

DCA Selec0 ~ /. host 
. Comm Serv~r "" m NetWare for 

l);! SM Server 

IBM host or 
peer computer 

Figure 1-1. Examples of mainframe connection types 
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Chapter 1 

The mainframe connection types are described in Table 1-1. 

Table 1-1. 

Installation 
choices 
Standalone 
connections 

Description of mainframe connection types 

Connection 
type 
Single-session 
(CUT) 

Multisession 
Coax (DFT) 

LAN Attached 
(802.2) 

Description 
Irma supports single-session CUT 
connectivity for a direct connection to an 
IBM® 3174/3274 control unit. 

Irma supports multisession DFT 
connectivity for a direct connection to an 
IBM 3174/3274 control unit. Each DFT 
adapter can only support up to five 
emulation sessions. 

Irma supports standalone, multisession 
802.2 connectivity with host and peer 
computers across a token-ring or Ethernet 
LAN through the IEEE standard 802.2 
data link control protocol. For stand-alone 
connectivity, you can use the following 
token-ring or Ethernet connections: 
• Connection to a 37xxfront-end 

processor connected to a host 
• Connection to a 3174 control unit 

connected to a 37xxfront-end 
processor and through the front-end 
processor to a host 

• Connection to a 9370 ICU connected 
internally to the 9370 host 

• Connection to a 3174-xL control unit or 
3174 local controller directly connected 
through a channel to a host 

Remote (SDLC) Irma supports direct, multisession SDLC 
connectivity to a 37xxfront-end processor, 
through an SDLC adapter and half-duplex 
synchronous modems, over switched or 
leased lines. 

X.25 Irma supports direct, multisession X.25 
Standalone connectivity to a 37xxfront-end processor, 

through an X.25 adapter and half-duplex 
synchronous modems, over switched or 
leased lines. 

Note In order to install X.25 connectivity, 
you must order the optional Irma 
X.25 Connection diskette from 
DCA. For ordering information, see 
"Ordering optional software" on 
page 2-3. 
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Table 1-1. Description of mainframe connection types (cont.) 

Installation Connection 

it choices type Description 
Standalone TN3270 over If you are a client on a TCP/IP network, 
connections TCP/IP you can access a TN3270 controller or 
(cont.) gateway by using a supported TCP/IP Chapter 1 

protocol stack and a LAN adapter. No 
additional adapter is required for your PC. 
Irma is supported with the following TCPI 
IP stacks: 
• Winsock 1.1, including Chameleon™ 

from NetManage™, TCP/IP for 
Windows version 3.1, IBM TCP/IP for 
DOS 2.1, SNAP-IX 

• Novell® LAN Workplace® 
• FTP Software PCITCpTM 

• Wollongong Pathway 
• Sun® PC-NFSTM 

• Microsoft LAN Manager or 3Com® 
• Walker Richer & Quinn (WRQ) 
• Frontier Super TCP/NFS 
• DEC® PATHWORKS™ 

Gateway ATLANTIS SNA If you are a client on a LAN, you can 
connections Gateway access an ATLANTIS SNA Gateway by 

using a LAN adapter configured to use the 
same protocol as the gateway. No 
additional adapter is required for your 
client. 

Digital SNA If you are a client on a PATHWORKS LAN, 
Gateway you can access a Digital SNA Gateway by 

using a LAN adapter configured to use any 
protocol supported by PATHWORKS. No 
additional adapter is required for your 
client. 

Eicon SNA If you are a client on a LAN, you can 
Gateway access an Eicon SNA Gateway by using a 

LAN adapter configured to use the same 
protocol as the gateway. No additional 
adapter is required for your client. 

DCA If you are a client on a LAN, you can 
IrmaLANTM access an IrmaLAN Gateway (for VINES®, 
Gateway NetBIOS, or NetWare®) by using a LAN 

adapter and the appropriate (VINES, 
NetBIOS, or IPXlSPX) protocol. No 
additional adapter is required for your 
client. 

What is irma'? 1-5 
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Table 1-1. Description of mainframe connection types (cont.) 

Installation 
choices 
Gateway 
connections 
(cont.) 

Connection 
type 
DCA Netway® 
2000 Gateway 

Novell NetWare 
for SAATM 
Gateway 

Description 
If you are a client on a LAN, you can 
access a Netway 2000 gateway by using a 
LAN adapter configured to use the same 
protocol as the gateway. No additional 
adapter is required for your client. 

If you are a client on a LAN and have 
access to a NetWare for SAA gateway, 
you can access the server by using the 
SPXlIPX or TCP/IP protocol and a LAN 
adapter. No additional adapter is required 
for the client. You can have simultaneous 
sessions using both IPXlSPX and TCP/IP 
protocols. 

Server Microsoft SNA If you are a client on a LAN and have 
connections Server access to an SNA Server, you can access 

the server by using the NetBEUl, SPXlIPX 
or TCP/IP protocols and a LAN adapter. 
No additional adapter is required for the 
client. 

DCA Select™ 
Comm Server 

Hewlett­
Packard® 
HP-UX SNApius 
Server 

Winsock TCP/IP 

If you are a client on a LAN and have 
access to a Select Comm Server, you can 
access the server by using the NetBEUl, 
SPXlIPX or TCP/IP protocols and a LAN 
adapter. No additional adapter is required 
for the client. 

If you are a client on a LAN and have 
access to an HP-UX SNApius Server, you 
can access the server by using the 
NetBEUl, SPXlIPX or TCP/IP protocols 
and a LAN adapter. No additional adapter 
is required for the client. 

If you are a client on a LAN and have 
access to a SNAP-IX server, you can 
access the server by using the Winsock 
1.1 TCP/IP protocol. No additional adapter 
is required for the client. 

1-6 What is trmn? 



Features 
Table 1-2 describes the Irma features. 

Table 1-2. Irma features 

Feature 
Application 
Programming 
Interface (API) 

Autosizing of 
fonts and 
session window 

Character 
support 

Diagnostics 

Dynamic Data 
Exchange (DOE) 
support 

File transfer 

Graphics 

HLLAPI 

Description 
The mainframe connectivity supports Advanced 
Program-to-Program Communication (APPC), 
Common Service Verbs (CSV), and Common 
Programming Interface Communications (CPI-C). 
Windows Open Systems Architecture (WOSA) APPC 
and CPI-C are also supported. 

Note Supported only with OFT, SDLC, 802.2, Select 
Comm Server, and SNA Server. 

You can choose to have the fonts automatically resize 
within the display window, or to have the window 
automatically resize to accommodate the font size. 

You can choose to use Country Extended Code Page 
(CECP), Extended Attribute Byte (EAB), and A 
Programming Language (APL). TrueType™ fonts 
(fixed pitch only) are also supported. 

The mainframe connectivity offers diagnostics for CUT, 
OFT, 802.2, SDLC, and X.2S connection types. 

You can link Windows applications using a protocol 
called Dynamic Data Exchange (DOE). Using DOE, 
you can transfer data on a one-time basis, or establish 
an ongoing dialog with other applications. 

You can perform multiple, concurrent file transfers to 
and from CICS, CMS, and TSO host environments 
using the following: 

• DCA FTIExpress™ 
• DCA IrmaLink® 
• IBM 3270 IND$FILE 

• PS/CICS 

Note IrmaLink is not supported with Select Comm 
Server. 

You can install the Irma Graphics software that is 
included with Irma. The mainframe connectivity 
supports All Points Addressable (APA) and 
Programmed Symbols (PS) graphics. 

Note Not available for CUT. 

You can use WinHLLAPI, EHLLAPI, and DOS HLLAPI 
with the mainframe connectivity. 

This is irma 
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Table 1-2. Irma features (cont.) 

Chapter 1 

1-8 Features 

Feature 
Input devices 

Keyboard 
mapping 

LUA 

Macros 

Microsoft Office 
Compatible 
Program support 

Multiple 
document 
interface (MOl) 

NetVieW® 

NetWizard™ 

Description 
You can JJse the mouse to emulate a light pen. In 
addition to standard PC keyboards, the mainframe 
connectivity also supports the following keyboards: 
• OCA IrmaKey/3270® 

• Memorex-Telex 
• Key Tronic® 
• SiemenslNixdoft 122-key 
• IBM 122-key keyboards 

You can change the location of the characters and 
functions on your keyboard using the Keyboard Editor. 
You can also assign scripts and keystrokes to specific 
keys. 

The mainframe connectivity supports both LUA and 
WOSA LUA. 

You can save keystrokes and assign them to a 
QuickPad™ or a keyboard key. 

The mainframe connectivity supports the Microsoft 
Office Compatible Program. 

You can view multiple windows concurrently, in either a 
cascaded or tiled format. You can reduce a window to 
an icon and close all windows simultaneously. 

You can communicate with IBM NetView through 3270 
user alerts 

Note Supported only with OFT, SOLC, 802.2, Select 
Comm Server, and SNA Server. 

If you purchased a multipack version of Irma, the 
NetWizard software is included. You can install the 
NetWizard feature, which allows you to manage 
distributed software applications across your LAN. 

Printer emulation You can configure a 3287 printer emulation session, 
that supports LU1 and LU3 type printing. 

Printer server 
capabilities 

Note TN3287 printing (LU1 and LU3) is supported 
with OpenConnect® System (OCS) TCP/IP­
SNA Gateways and McOata 6100/6200 
controllers only. 

You can use the printer emulator as a print server, 
including font mapping. 



Table 1-2. Irma features (cont.) 

Feature 
Profiles 

QuickBar 

QuickDDE 

QuickExec™ 

QuickHitTM 

QuickPad 

QuickSAA 

QuickScriptTM 

QuickSend 

Response lime 
Monitor (RTM) 

Description 
A profile contains the name and description of the host 
system. The profile also contains connection 
information, terminal emulation settings, and keyboard 
definitions. The software includes a default session 
profile and several profiles that have already been 
configured and are ready to use to connect to the host. 

The QuickBar displays icons that initiate tasks, such as 
file transfers and screen captures. You can start these 
tasks quickly by clicking on the icons. For mainframe 
connectivity, you can also customize your QuickBar by 
moving and deleting icons. You can even create your 
own QuickBars. 

You can use this tool to simplify the process of 
developing a DDE link between Irma and another 
application. 

You can define a set of applications to execute when a 
single icon is selected. 

QuickHit lets you use the mouse to choose characters, 
words, or function keys displayed by the mainframe 
application, and send them to the host. 

During a communications session, you can execute 
commands using a QuickPad instead of your 
keyboard. A QuickPad is a small window you create 
that contains objects you click on to initiate host 
commands You can also assign functions to different 
objects on a QuickPad, such as running scripts or 
sending keystrokes to the host. 

You can select a host menu item by using the mouse. 
The menu item is then entered automatically in the 
data field. 

You can create, edit, compile, and run scripts using the 
QuickScript editor and the SISL scripting language. 

You can use the Windows File Manager and the drag­
and-drop feature to initiate file transfers from your PC 
to a CICS, CMS, or TSO host environment using 
IND$FILE or IrmaLink. 

Note IrmaLink is not supported with Select Comm 
Server. 

You can display RTM in graphical format. 

Note Supported only with DFT, SDLC, 802.2, Select 
Comm Server, and SNA Server. 
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Table 1-2. Irma features (cont.) 

Chapter 1 

1-10 FfJl1tun!ls 

Feature Description 
Screen capture During a communications session, you can copy the 

contents of the terminal screen and save it in a file, or 
you can send it to a printer. 

Screen You can customize your screen display, such as the 
customization character fonts, colors and audible signals, by 

modifying the terminal emulation settings. 

Scripts 

Shared access 

Terminal 
emulation 

Text files 

Uploading ASCII 
text files 

You can record and save a series of keystrokes to 
perform a task. You can also create, compile, and run 
scripts using the Script Editor and the SISL ™ 
language. 

You can choose to install Irma with shared access. This 
means that one copy of the Irma program files is 
installed to a server, and multiple users can run Irma at 
the same time. This type of installation also requires 
you to run a Setup program at each workstation that 
installs the Irma program group, and installs some files 
into a private directory for that workstation. 

You can use up to five concurrent mainframe sessions, 
using models 2 through 5. You can choose to use "any" 
model type so that your display window accommodates 
any model that the host application is using. You can 
even conduct display emulation through the serial port 
on your PC. 

You can cut, copy, and paste text and tables between 
the host and the PC. 

During a communications session, you can send an 
ASCII text file to the host computer. 



What's new with Irma? 
If you have previously used IRMA WorkStation for Windows, you may ~ 
notice several changes in the Irma product, as follows: .. 

• You no longer configure your communications adapters and connections Chapter 1 

by running the Setup program. After you have installed Irma and you start 
the appropriate application, you are prompted automatically to configure 
your adapters and connections. Later, if you need to make changes to the 
configuration, you can do so from the display application. 

• If you install Irma with Shared Access, and you run the Setup at the 
workstation that wants to use the shared access software, you must supply 
a private path for that workstation. You no longer specify a private path if 
you install Irma as a Personal Copy. 

The biggest change is that many of the icons that you used to see in the IRMA 
WorkStation for Windows program group are gone. The applications that you 
are familiar with are still in the product, but you now access those 
applications from one of the new Irma icons. For descriptions of the new 
icons contained in the Irma program group, see "About the Irma applications" 
on page 1-13. 

The following sections describe how to access the applications that you used 
in a previous DCA product. 

Icons you saw in IRMA WorkStation for 
Windows 

When you first access the Irma program group, you may notice that there are 
fewer icons than you saw in the IRMA WorkStation program group. 
Applications that once had separate icons in the program group are now 
integrated and available through Mainframe Sessions. 

What's fllfJW with irma? 1-11 



This Is Irma 

Chapter' 

Table 1-3 presents the icons that appeared in the last version of the IRMA 
WorkStation product, and tells you how to access the associated application 
inInna. 

Table 1-3. Accessing applications in Irma versus 
IRMA WorkStation for Windows 

IWW 2.x icons 
QuickScript 

3270 Printer 

Configurator 

QuickExec 

Keyboard 
Editor 

APPC 

To access this application in Irma, start 
Mainframe Sessions and ... 
Choose Run, Edit, or Learn Script from the 
QuickTools menu. 

Choose New Printer from the File menu. 

Choose Session Configuration from the Settings 
menu. 

Choose Diagnostics from the Help menu. 

Choose Edit QuickExec from the QuickTools menu. 

Choose Select Keyboard or Edit Keyboard from the 
Settings menu. 

APPC connectivity is available through a new API 
program group icon. 
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About the Irma applications 
Based on the connectivity type you select during the Irma installation, the 
associated applications are installed. Table 1-4 describes the Irma 
applications. 

Table 1-4. 

Application 

ii 
Main/rame 
Sessions 

API Support 

Irma applications 

Description 
Use this application to start, configure, use, and 
customize mainframe display and printer sessions. 
You can capture emUlation screens to the disk or the 
printer, edit screen contents, and run HLLAPI 
programs. 

Several options are found under Mainframe 
Sessions menus that were formerly separate 
program group icons, such as: 
• To configure a mainframe session, choose 

Session Configuration from the Settings menu. 
• To start, use, and customize mainframe display 

sessions, choose New Display from the File 
menu. 

• To start, use, and customize mainframe printer 
sessions, choose New Printer from the File menu. 

• To select or edit a keyboard, choose Select 
Keyboard or Edit Keyboard from the Settings 
menu. 

• To work with QuickScript, choose Run, Edit, or 
Learn Script from the Quicktools menu. 

• To edit a QuickExec file, choose Edit QuickExec 
from the Quicktools menu. 

• To access diagnostic information, choose 
Diagnostics from the Help menu. 

Use this application to start an SNA (LU 6.2) session 
that can be used by APPC transaction programs or 
CPI-C applications. The session is automatically 
started for you. For information about APPC, see the 
DCA APPC Programmer's Guide provided in the 
optional DCA Distributed Applications Developer's 
Tool Kit. For information on ordering this tool kit, see 
"Developing your own applications" on page 5-6. 

Note APPC support is not available for CUT, 
TN3270, IrmaLAN NetBIOS, IrmaLAN IPXI 
SPX, IrrnaLAN VINES, Eicon SNA Gateway, 
Digital SNA Gateway, ATLANTIS SNA 
Gateway, and Netway 2000 Gateway. 
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Table 1-4. Irma applications (cont.) 

Application 

~ 
Redirector 

QuickExec: 
START 

Setup 

I 
Read-This 

Description 
Use this application to start the DOS HLLAPI 
redirector feature. 

Use this application in conjunction with the 
QuickExec feature. After you have set up your 
QuickExec profile that executes a set of applications, 
you assign that profile name to this Icon. Clicking on 
this icon then starts all the associated applications. 

After you install Irma, use this application to add 
connection types, install an option disk, change the 
program group, change the keyboard driver, or 
change the host language. This application is 
installed automatically. 

Read this file first to learn important, additional 
information about the product. This icon is added 
automatically to the program group. 
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About the file types used by Irma 
Irma uses several file types to store your configuration and customization 
information. 

The Mainframe Sessions application uses several file types to store your 
configuration and customization information. Table 1-5 presents the file 
types, their extensions, and a description of each file type. 

Table 1-5. File types used by Mainframe Sessions 

File 
File type extension 
Style file . CCF 

Display profile .EMU 

File transfer 
profile 

SISL source 
file 

SISL 
compiled file 

Keyboard 
profile 

.FT 

. ISL 

.ISX 

.KBD 

Description 
Contains session configuration information . 
Only one style file can be in use at one time. 
Settings contained in this file apply to all 
active mainframe sessions. 

You can invoke a customized style file by 
adding the style filename to the mainframe 
session command as follows: 

EMU Istyle_file.CCF 

Contains configuration information about the 
display window size, fonts, and colors. It 
also allows the session to be activated 
automatically. There is one profile per 
mainframe display session. 

To invoke a customized profile, add the 
profile name to the mainframe display 
command as follows: 

EMU.EXE profile.EMU 

Contains configuration information about file 
transfers including type of file, direction of 
the transfer, and the host filename type 
mode. You can create multiple file-transfer 
profiles, but you can invoke only one profile 
at a time . 

Contains stored keystrokes, along with SISL 
commands. This file can be edited by the 
QuickScript Editor or any text editor. 

Contains the compiled output of a SISL 
source file. This is an executable file. 

Contains information about the keyboard 
mapping. You can use only one keyboard 
profile at a time. 

Chapter 1 
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Table 1-5. File types used by Mainframe Sessions (cont.) 

File type 
Log files 

Printer profile 

QuickPad 
profile 

QuickExec 
profile 

Screen 
capture 

Trace files 

Summary 

File 
extension _Description 
.LOG Contains audit information when you use the 

diagnostics feature. 

.PRT Contains configuration information about 
mainframe printer emulation. There is one 
profile per mainframe printer session . 

. QBD Contains the definition for a QuickPad, 
including the size and key layout. You can 
use only one QuickPad at a time . 

. QEP Contains configuration information that 
allows you to start multiple applications by 
clicking on a single icon . 

. SCR If you perform a screen capture and save 
that screen capture to a disk file, the 
extension used is .SCR. 

.TRC Contains tracing information. You initiate 
traces by using the diagnostics feature. 

In this chapter, you learned about the following: 

o What Irma is, the connectivity types supported, and the features 
provided 

o The differences between Irma and previous DCA products 

o The applications that are included 

o The file types that Irma uses 

Now tum to the next chapter to prepare for installing Irma. In Chapter 2, 
"Before You Install Irma ," you will complete planning checklists that make 
installing Irma easier. 
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Before You Install Irma 

• Checking your package contents 2-2 

• Ordering optional software 2-3 

• Hardware requirements 2-3 

• Software requirements 2-6 

• Upgrading from a previous version of a DCA product 2-9 

• Installation checklists 2-10 

• Summary 2-15 
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Complete your planning 
checklist 

Install Irma 

Learn about online help 

Configure the connection and 
start a communications session 

Customize your session 

Resist the temptation to run the 
Setup program before you read this 
chapter! 

This chapter describes the Irma 
package contents, and explains how 
to order optional software. This 
chapter lists all the hardware and 
software requirements for each con­
nection type. If you have a previous 
DCA product installed, you'll learn 
how to upgrade to Irma for the 
Mainframe. 

You'll need about 15 minutes to 
read this section and complete the 
checklists. 

Checking your package contents 
In addition to this Getting Started Guide, make sure your package includes 
the 3.5" high-density diskettes shown in Table 2-1. 

Table 2-1. Irma diskettes 

Disk label 

Mainframe Program 
Disks 1-5 

Mainframe Language 
Support Disk 

Description 

These diskettes contain all of the program 
files for mainframe connectivity. 

This diskette contains language files. You 
will need this diskette if you choose to 
install a language other than U.S. English. 



Ordering optional software 
DCA offers optional software packages that can enhance the Irma feature set, 
as described in Table 2-2. 

Table 2-2. Irma optional software 

Disk label 

X.25 Connection Disk 

Irma Graphics for 
Windows 

Description 

Optional. This diskette provides X.25 
support for mainframe connectivity. 

This package contains the Irma Graphics 
software and a User's Guide, and can be 
installed if you want APA graphics 
capabilities. 

To order any of these products at a substantial discount, call DCA Sales 
Operations at 1-800-348-3221, extension 809. 

Hardware requirements 
Irma requires the following hardware: 

• Any PC, monitor, mouse, and keyboard supported by Windows 3.1 or 
Windows for Workgroups 3.11. 

• A minimum of 4 MB of system RAM, 6 MB is recommended. 

• A printer supported by Windows 3.1 (optional). 

• A minimum of free hard-disk space as described in Table 2-3. 

Table 2-3. Hard-disk space requirements 

Standalone CUT 

OFT 

802.2 

SOLC 

X.25 

TN3270 

6.7 

8.3 

8.0 

7.9 

8.0 

7.0 
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Table 2-3. Hard-disk space requirements (cont.) 

Gateway ATLANTIS SNA Gateway 7.2 

Server 

All standalone and 
gateway connections 
(except X.25) 

Digital SNA Gateway 

Eicon SNA Gateway 

IrmaLAN IPXlSPX 

IrmaLAN NetBIOS 

IrmaLAN for VINES 

NetWare for SAA 

HP-UX SNApius Server 

Select Comm Server 

SNA Server for Windows NT 

Winsock TCP/IP client 

7.5 

7.0 

7.2 

7.2 

8.1 

7.5 

6.5 

6.1 

8.7 

7.0 

10 

You can install more than one standalone and gateway connection type, or 
you can install one server connection type. 

Note You can install multiple connection types; however, you can activate 
only one connection type at a time. 

• A minimum of 1 MB of additional system RAM if you are using Irma 
Graphics for Windows. Additional RAM will improve performance if you 
are displaying multiple complex graphics. 

• One of the following adapters: 

- If you install Irma with a gateway or server connection type, you need 
to install a LAN adapter supported by the LAN operating system. 

- If you install Irma with a standalone connection type, you need to 
install at least one communications adapter. 



Table 2-4 lists the communications adapters supported by Irma. 

Table 2·4. Communications adapters supported by 
Irma 

Connection 
CUT and OFf 

SOLC 

802.2 

TN3270 

Supported adapters 
DCA Irma 2, Irma 3®, Irma 3 Convertible, and Irma 
3270 Pocket adapters 

IBM 3278/79 Emulation Adapter (including Rev B), 
3278/9 Advanced Emulation Adapter (including 
Rev B), 3270 Connection Adapter, Model A 
(including Rev B) and Model B (including Rev B) 

Attachmate® Advanced 3270 Adapter and 
Advanced 3270 Adapter/2 

DCA Synchronous Communications Adapter 
(SCA) 

IBM SOLC Adapter, Multiprotocol Communications 
AdapterlA 

Pathways SOLC Adapter 

Microdyne IrmaTrac™ Convertible Token-Ring 
Adapter 

IBM Token-Ring Adapter, Token-Ring Adapter II, 
Token-Ring Adapterl A, Token-Ring 16/4 Adapter, 
Token-Ring 16/4 AdapterlA 

Proteon 4, 16, or 4/16 Mbps Token-Ring Adapter 

Madge 4, 16, or 4/16 Mbps Token-Ring Adapter 

Any Ethernet adapter supported by the IBM LAN 
Support Program 

Any token-ring or Ethernet adapter that is 
supported by an FfP (version 2.05p14 or newer), 
Novell LAN WorkPlace, Wollongong Pathway 
Access, Walker Richer & Quinn, Winsock 1.1 
compatible stacks, Sun PC-NFS, or Microsoft LAN 
Manager, 3Com, DC PATH WORKS 4.1 or newer 
TCP/IP protocol stack, Frontier Super 
TCP/NFS 
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Table 2-5 lists the maximum number of adapters supported. 

Table 2-5. Maximum number of adapters and connections 
supported by Irma 

Connection type 
OFT 

Token-ring 

SOLe 
X.25 

Maximum 
number of 
adapters 

Connections per 
adapter 

4 

4* 

4 

You can configure four connections per link service for SOLC only when 
configuring multipoint connections where Irma is the primary station for APPC 
only. 

Software requirements 
Before you install Irma, you must install the following on your system: 

• One of the following: 

- Microsoft Windows version 3.1 or newer. 

or 

- Windows for Workgroups 3.11. 

• If you want to use FflExpress to transfer files, your host application 
(available from DCA) must be version 2.0 or newer. 

• If you want to use LU 6.2, you must have VTAM™ version 3.2, with NCP 
version 5.2 (3745 systems) or NCP version 4.3 (3725 systems). 



• If you want to install Irma with a server connection, TN3270, or gateway 
connections, you also need to install the software as shown in Table 2-6. 

Table 2-6. Software requirements for mainframe connectivity 

Connection 
type 
ATLANTIS 
Gateway 

IrmaLAN for 
VINES Gateway 

IrmaLAN 
Gateway 

Netway 2000 
Gateway 

Digital SNA 
Gateway 

Eicon SNA 
Gateway 

Irma PC 
For DOS and OS/2 servers: 
Any LAN client software 
that uses NetBIOS. 
For UNIX servers: TCPIIP 

Banyan client software 
configured for NetBIOS, 
IPXlSPX 3.10 or newer, or 
VINES IP 4.1 or newer 

Any LAN client software 
configured for NetBIOS or 
NetWare I PXlSPX 3.10 or 
newer 

NetWare IPXlSPX 3.10 or 
newer 

PATHWORKS 4.1 or newer 

Any LAN client software 
configured for NetBIOS, 
IPXlSPX 3.10 or newer, or 
VINES IP 

The following files, provided 
by Eicon: 

• NABIOS.EXE 
• NARDR.CMD (NetBIOS 

only) 
• NARDRSPX.CMD 

(IPXlSPX only) 

• ECLAN.EXE 

Gateway/server 
requirements 
ATLANTIS Gateway, 
8.00a or newer 

IrmaLAN for VINES 
Gateway, 3.0.7 or newer 

DCA IrmaLAN, 3.0 or 
newer 

DCA Netway 2000 
Gateway, 4.2 or newer 

Digital SNA Domain 
Gateway-ST 1.1 or 
newer, SNA Domain 
Gateway-CT 1.1 or 
newer, DECnetlSNA 
Gateway-ST 1.2 or 
newer, DECnetlSNA 
Gateway-CT 2.1 or 
newer, DEC SNA Peer 
Server 1.0 or newer 

Eicon SNA Gateway, 3.0 
release 1 or newer 
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Table 2-6. Software requirements for mainframe connectivity (cont.) 

Connection Gateway/server 
type Irma PC requirements 
Novell NetWare NetWare 3.11 or newer. NetWare 3.x, 4.x, or 
for SM gateway Make sure you have the newer 
client following file versions: 

NetWare for SM 

it 
• IPX.COM 3.10 or newer. gateway 1.x or newer 

If you are installing Irma (for IPX) or 1.3B (for 
on a 486 PC, we TCP/lP) 
recommend that you run 

ChaptIN2 the 001 driver, instead of 
WSGEN.EXE. 

• LSL.COM 3.22 or 
newer, or PXODI.COM 
1.2 or newer, if you are 
running the 001 driver. 

• NETX.COM 3.22 for PCs 
using conventional 
memory. 

• EMSNETX.EXE 3.22 or 
newer for PCs using 
expanded memory. 

• XMSNETX.EXE 3.22 or 
newer for PCs using 
extended memory. 

You can also use TCP/IP 
protocol 1.3b or newer. 

HP-UX LAN Manager client Hewlett-Packard 
SNApius Server software 2.2 or newer, HP-UX 9.0 or newer, 

configured for TCP/IP. with HP STREAMS/UX 
for Series 700 and 800 

LAN Manager for HP 
90002.2 

HP-UX SNAplusLink 
2.0 or newer 

Microsoft SNA Windows NT 3.1 or 3.5 Microsoft Windows NT 
Server client configured for NetBEUI, Workstation 3.1 or 3.5; 

SPXlIPX, or TCP/IP or Microsoft Windows 
protocol. NT Server 3.1 or 3.5 

Microsoft SNA Server 
2.0 or 2.1 

SelectComm Microsoft LAN Manager 2.1 DCA Select Comm 
Server or newer; IBM LAN Server Server 1 .2 or newer 

1.3, 2.0 or newer. 



Table 2-6. Software requirements for mainframe connectivity (cont.) 

Connection 
type 
Winsock 
TCP/IP 

TN3270 

Irma PC 
Windows socket 
specification 1 .1 . 

Gateway/server 
requirements 
Any SNAP-IX compliant 
server software 

One of the following TCP/IP One of the following: 
protocol-stacks: • IBM 3172, 3745, or 
• FTP version 2.05p14 or 8234 controller with 

newer 
• Novell LAN WorkPlace 
• Wollongong Pathway 

Access 

• Walker Richer & Quinn 
• Microsoft LAN Manager, 

or3Com 

• DEC PATHWORKS 4.1 
or newer 

• Sun PC-NFS 
• Winsock 1.1 compatible 

stacks 

• Frontier Super TCP/NFS 
version 4.00 

Telnet Server on the 
host 

• OpenConnect Server 
II 

• MacData 6100 
• Interlink 
• Intel® 9770 
• anyTN3270 

compatible gateway 

Upgrading from a previous version of a 
DCA product 

If you have previously installed a DCA product, you do not need to remove it 
before installing Irma. 

The Irma Setup program detects that the software exists, and uses the existing 
configuration information as the new default configuration. 

When you run the Irma Setup program, remember the following: 

• If you specify the same destination directory as the directory where the 
older software resides, the new files are copied over the older files. 

• If you specify a different destination directory from the directory where the 
older software resides, the older files are not deleted by the Setup program. 
If you want to delete the older files, you must do so manually. 

In addition, the Setup program prompts you to select which types of 
configuration files and profiles to save. For more information about the file 
types and their extensions, see "About the file types used by Irma" on 
page 1-15. 
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Using existing configuration files and profiles 

If you have a previous version of IRMA WorkStations for Windows installed, 
the Setup program will prompt you to select which types of configuration 
files and profiles to save. For more information about the file types and their 
extensions, see "About the file types used by Irma" on page 1-15. 

Installation checklists 
These installation checklists were designed to make the installation process 
easier for you. 

Before you install Irma, you need to do the following: 

o Make backup copies of the diskettes containing the Irma software. 

o Make sure you have the required hardware. For more information, see 
"Hardware requirements" on page 2-3. 

o Make sure you have the correct versions of software installed. For 
more information, see "Software requirements" on page 2-6. 

o Determine the destination drive and directory for the Irma software. 

Drive and directory: ______________ _ 

o Decide which Install Type you want to use: 

_ Personal Copy, which installs Irma for a single user. 
_ Shared Access, which allows you to install Irma to a shared drive so that 

multiple users can access the same program files. 

o Decide if you need to use Complete Installation or Custom 
Installation: 

_ Complete Installation installs all stand-alone connection types (except 
for X.25) and all gateway connection types. 

_ Custom Installation allows you to select connection types and 
applications to install. Use this option if you want to install a server 
connection or an X.25 stand-alone connection. Be sure to complete the 
"Additional checklists for Custom Installation" on page 2-13. 

o If you have a previous version of Irma installed, decide if you want to 
save the existing configuration files (For a complete list of file types, 
see "About the file types used by Irma" on page 1-15.): 

_yes 
no 



D Decide if you want the Setup program to automatically change the 
system files. If not, you must do this step manually. We recommend 
that you let the Setup program perform this step automatically. Your 
current system files will be backed up by the Setup program. 

_yes 
no 

D If you are going to install Irma Graphics, be sure you have the optional 
diskette labeled "Irma Graphics" available from DCA. For more 
information, see"Ordering optional software" on page 2-3. 

Checklist for TN3270 connections 

Complete the following checklist for TN3270 connections: 

D Install the LAN adapter in your PC. 

D Install the TCPIIP protocol software required for your controller, 
gateway or server. For more information, see "Software requirements" 
on page 2-6. 

D Make sure you can access the TN3270 network by typing the 
following command at a command prompt: 

PING host 

In this statement, host is the address of the TCPIIP host or the TCPIIP host 
name. 

This utility indicates whether or not data is being sent successfully over the 
TCPIIP network. 
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Checklist for standalone connections 

Complete the following checklist for standalone connections: 

o Install the communications adapter(s) you are going to use in your PC. 

Record all the hardware settings you select because you will need to enter 
the information when you configure your links. Note that not all adapters 
use all the following settings: 

Interrupt 
DMAchannel 
110 Address 
110 Base Address 
Memory Segment Address 
Driver name 

Caution If the parameters you enter in the configurator do not match your 
hardware configuration, Irma may not operate correctly. 

Some communications adapters require that you install the drivers and 
reboot your PC so that the drivers are loaded before you can run the Irma 
Setup program. 

o If you are going to use X.25 as your standalone connection type, be 
sure you have the optional diskette labeled "Irma X.25 Support," 
available from DCA. For more information, see"Ordering optional 
software" on page 2-3. 

Checklists for gateway or server connections 

Complete the following checklist for gateway or server connections: 

o Install the LAN adapter in your PC. 

o Install the LAN client software required for your gateway or server 
connectivity. Configure your adapter to use the same protocol your 
gateway or server uses. For more information, see "Software 
requirements" on page 2-6. 

o Determine whether you have the necessary privileges to use the LAN 
resources, including the gateway or server communications 
capabilities. If you have questions, ask your LAN administrator. 



Additional checklist for Eicon SNA Gateway 

Complete the following checklist for an Eicon SNA Gateway connection: 

o Install the DOS Workstation Communications Drivers that are 
included with the Eicon Gateway. For more information, refer to the 
documentation provided by Eicon. 

o The following files, provided by Eicon, should be copied to your PC 
into a directory that is in your search path: 

NABIOS.EXE 
_ NARDR.CMD (for NetBIOS only) 
_ NARDRSPX.CMD (for IPXlSPX only) 

ECLAN.EXE 

o If you are using a 386 or 486 in Enhanced mode, the following lines 
must be added to the SYSTEM.IN! file under the [386Enh] section: 

device=[path]VNABIOS.386 
NAHEAPSIZE=nn 

[path] is the complete path to the directory in which your Eicon files 
reside, and nnis a numeric value. Usually, 45 should be an acceptable 
value. 

If the device statement is missing from the SYSTEM.INI file, a pop-up 
message is displayed stating that "NABIOS not loaded properly: 100." 

If the NAHEAPSIZE statement is missing from the SYSTEM.INI file, a pop­
up message may be displayed stating that the value should be increased. 

Additional checklists for Custom Installation 

If you choose to install the mainframe connectivity using the Custom 
Installation, complete this checklist. 

o Decide what connection types you want to install. You can install any 
number of standalone and gateway connection types or you can install 
a single server connection type. 

Select one of the following server connection types: 

_HP-UX SNAplus Server 
_ DCA Select Comm Server (Be sure to complete the "Additional 

checklist for Select Comm Server" on page 2-14.) 
Microsoft SNA Server 
Winsock TCP/IP client 
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Or, select any number of the following standalone and gateway connection 
types: 

_ LAN Attached (802.2) 
_ Multi-Session Coax (DFf) 
_ Remote (SDLC) 
_ Single Session (CUT) 
_X.25 Standalone (requires the options X.25 Connection diskette) 

TN3270 over TCP/IP 
_ ATLANTIS Gateway 
_ DCA IrmaLAN for VINES Gateway 
_ DCA IrmaLAN NetBIOS Gateway 
_ DCA IrmaLAN NetWare Gateway 
_ DCA Netway 2000 
_ Digital SNA Gateway 
_ Eicon SNA Gateway 
_Novell NetWare for SAA Gateway 

o Decide which applications to install: 

_ APPC/CPI-C (supported only with DFf, SDLC, 802.2, Select Comm 
Server, and SNA Server) 
DOS HLLAPI redirector 
EHLLAPI 

_ LUA support (supported only with DFf, SDLC, 802.2, Select Comm 
Server, and SNA Server) 

_ Mainframe Display 
_ Online Help (You should install online help since it contains most of the 

information you need to configure, use, and customize Mainframe 
Display.) 

_QuickDDE 
WinHLLAPI 

Additional checklist for Select Comm Server 

If you want to install the mainframe connectivity with a Comm Server 
connection, you need the following information from your system 
administrator: 

o Determine the name of the Select Comm Server PC. 

Name of Comm Server PC: ____________ _ 

o Make sure you have read access privileges for the Comm Server 
\COMMSRV directory. See your system administrator for more 
information. 

o If you are running DOWNLOAD.EXE in your AUTOEXEC.BAT file, 
remove this statement and reboot your PC before you install Irma. 
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Summary 
In this chapter, you learned about the following: 

o The Irma package contents 

o How to plan for your Irma installation 

o What hardware and software you need for each connectivity type 

o How to upgrade from previous DCA emulation products 

You should also have completed your installation checklists for your specific 
connectivity types. Now turn to Chapter 3, "Installing Irma," and follow the 
step-by-step instructions for installing Irma. 
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your p!&nn1ng 

Install Irma 

Learn about online help 

Configure the connection and 
start a communications session 

Customize your session 

In this chapter, you'll learn how to install 
Irma using either the Personal Copy or 
Shared Access installation types. This 
chapter also tells you how to do a 
Complete Installation or a Custom 
Installation. You'll also learn what the 
Setup program does, and how to run the 
Setup program after Irma is installed. 

If you completed the installation 
checklists in Chapter 2, installing Irma will 
be very easy. 

You'll need about 15 minutes to complete 
the installation process. 

Running the Setup program 
Be sure to have your completed installation checklists handy as you run the 
Setup program. 

Note Before running the Setup program, read the READTHIS.wRI file that is 
located on the Irma Setup diskette. It may contain additional information 
that you need before proceeding with the installation. 

To run the Setup program, follow these steps: 

1 Start Windows. 

2 Insert the diskette labeled Irma for the Mainframe Setup Disk 1 in any 
available disk drive on your Pc. 

3 Choose Run from the Windows Program Manager File pull-down. 

4 In the Command Line edit box, enter the following command and press 
[Enterl: 

drive:\SETUP 

In this command, drive is the drive where you inserted the Setup disk. 

The Irma title screen is displayed. Then the DCA License Agreement is 
displayed. 

5 Read the DCA License Agreement using the scroll bar to view the text. 



6 When you have finished reading the License Agreement, choose "I have 
read the entire license agreement and I agree." The Irma Setup dialog box 
is displayed, as shown in Figure 3-1. 

Figure 3-1. The Setup dialog box 

7 Do the following: 

To ... Then ... 

Change the default destination direction Choose Change Directory. Then use the 
Install Location dialog box to select the 
destination drive and directory. 

Chapter 3 

You can select from the drive list to set the 
installation directory; however, this process 
is slow because the entire drive must be 
scanned. 

Change the host language (character set) Change Language. Then use the Language 
or to select CECP support dialog box to select the host language and 

select CECP support. 
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8 Do one of the following: 

To ••• 

Perform a complete installation with all 
connections* 

Perform a custom installation, which 
allows you to select the connections you 
want to install 

Then ••• 

Choose the Complete Installation button. 

Choose the Custom Installation button. 

• This installation installs all mainframe gateways and standalone connection 
types (except for X.25 connectivity). To install a server connection type or 
X.25 connectivity, you must perform a custom installation. 

9 Do one of the following: 

To ••• Then ••• 

Install the software for a single user Choose Personal Copy as the install type, 
and read the next section "Installing a 
personal copy." 

Installing a personal copy 
Continue reading this section if you chose Personal Copy as the Install type. 
Read either "Complete Installation" or "Custom Installation," depending on 
the selection you made earlier in the Setup program. 

Complete installation 

Continue reading this section if you chose Complete Installation. 

1 Do one of the following: 

H ••• 
The Setup program detects 
that you already have a 
version of Irma installed. 

Then ••• 

The Save Configuration Files dialog box 
is displayed as shown in Figure 3-2. 
Continue with the next step. 

The Setup program does not Skip to step 3. 
detect that you already have 
a version of Irma installed. 



Figure 3-2. The Save Configuration Files dialog box 

2 Do one of the following: 

Choose this option .•• 

Save 

Don't Save 

To ••• 

Save the selected configuration files to a 
temporary directory. 

Not save any of your previous 
configuration files. 

3 At this point, the Irma files are copied to the destination directory. You are 
prompted to remove each diskette from the drive and insert the next 
diskette. 

Note You can stop the installation process at any time by choosing 
Cancel. 

When the files have completed copying, the Group Box dialog box is 
displayed. 

4 Do one of the following: 

Select this option •.• 

User Defined 

Any program group from 
the list box 

5 Choose OK. 

To ••• 

Create a new program group containing 
the Irma icons. 

Add the Irma icons to an existing program 
group. 
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6 If you selected User Defined, the Name Group Box dialog box is 
displayed. Enter the new group box name and choose OK. You are 
returned to theDroup Box dialog box. Then choose OK. 

. 
The Update System Files dialog box is displayed, as shown in Figure 3-3. 

Figure 3-3. The Update System Files dialog box 

7 Do one of the following: 

Choose this option ••• 

Make Changes 

Save Changes as *.IWW 

Abandon All Changes 

Restart Setup 

To ••• 

Automatically change the system files 
AUTOEXEC.BAT, WIN.INI, and 
SYSTEM.INI. 

Save the changes to a separate file. You 
must incorporate the changes to the 
individual files manually. The dialog box 
displays recommended changes to the 
AUTOEXEC.BAT file and allows you to 
edit the file. Use the Undo button to undo 
incorrect changes. Once Setup has edited 
the files, it displays the message "Changes 
have been made" and shows you where it 
stores the original files. 

Cancel the Setup program. 

Return to the first screen of the Setup 
program. 

If you had a previous version of Irma installed, and you selected to save 
your configuration files, a Setup dialog box is displayed asking if you want 
to restore those files from the temporary directory to the new Irma 
directory. 



8 Do one of the following: 

Choose this option ... 

Yes 

No 

To .•• 

Move all the saved configuration files 
from the temporary directory to the Irma 
directory. 

Keep all the saved configuration files in 
the temporary directory. You can 
manually move them to the Irma 
directory at a later time. 

The Setup Complete dialog box is displayed. 

9 Do one of the following: 

Choose this option ••• 

Restart PC Now 

Do Not Restart 

To ••• 

Close all your applications and restart 
Windows. 

Continue working with Windows; 
however, you must restart Windows 
before using Irma. 

At this point, the installation is complete. You can skip the next section, and 
turn to "What the Setup program does" on page 3-22. 
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Custom Installation 

Continue reading this section if you chose Custom Installation. 

At this point, the Connections dialog box is displayed as shown in Figure 3-4. 

Figure 3-4. The Connections dialog box 

The following table describes the options on the Connections dialog box. 

Choose this option ••• 

Standalone or Gateway 

Server Connections 

Add 

Remove 

Add All 

Remove All 

To ... 

Display the standalone and gateway 
connection types in the Connections 
Chosen list box. 

Display the server connection types in the 
Connections Available list box. 

Move the highlighted connection type 
from the Connection Available list box to 
the Connections Chosen list box. 

Move the highlighted connection type 
from the Connections Chosen list box to 
the Connections Available list box. 

Move all connection types from the 
Connections Available list box to the 
Connections Chosen list box. 

Move all connection types to the from the 
Connections Chosen list box to the 
Connections Available list box. 



Note You must choose at least one connection type. 

Follow these steps: 

1 Once you have selected your desired connections, choose OK. The 
Applications dialog box is displayed as shown in Figure 3-5. 

Figure 3-5. The Applications dialog box 

The following table describes the options on the Applications dialog box. 

Choose this option ••• 

Add 

Remove 

Add All 

Remove All 

To ••• 

Move the highlighted application from 
the Applications Available list box to the 
Applications Chosen list box. 

Move the highlighted application from 
the Applications Chosen list box to the 
Applications Available list box. 

Move all applications from the Appli­
cations Available list box to the 
Applications Chosen list box. 

Move all applications from the Appli­
cations Chosen list box to the 
Applications Available list box. 

Note You must choose at least one application to install. 

2 Once you have selected your desired applications, choose OK. 
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3 Do one ofthe following: 

H ••• 

The Setup program detects 
that you already have a 
version of Irma installed. 

Then ... 

The Save Configuration Files dialog box 
is displayed as shown in Figure 3-6. 
Continue with the next step. 

The Setup program does not Skip to step 5. 
detect that you already have 
a version of Irma installed. 

Figure 3-6. The Save Configuration Files dialog box 

4 Do one of the following: 

Choose this option ••. 

Save 

Don't Save 

To .•• 

Save the selected configuration files to a 
temporary directory. 

Not save any of your previous 
configuration files. 

5 At this point, the Irma files are copied to the destination directory. You are 
prompted to remove each diskette from the drive and insert the next 
diskette. 

Note You can stop the installation process at any time by choosing 
Cancel. 

When the files have completed copying, the Update System Files dialog 
box is displayed, as shown in Figure 3-7. 



Figure 3-7. The Update System Files dialog box 

6 Do one of the following: 

Choose this option ••• 

Make Changes 

Save Changes as *.IWW 

Abandon All Changes 

Restart Setup 

To ••• 

Automatically change the system files 
AUTOEXEC.BAT, WIN.INI, and 
SYSTEM.INI. 

Save the changes to a separate file. You 
must incorporate the changes to the 
individual files manually. The dialog box 
displays recommended changes to the 
AUTOEXEC.BAT file and allows you to 
edit the file. Use the Undo button to undo 
incorrect changes. Once Setup has edited 
the files, it displays the message "Changes 
have been made" and shows you where it 
stores the original files. 

Cancel the Setup program. 

Return to the first screen of the Setup 
program. 

If you had a previous version of Irma installed, and you selected to save 
your configuration files, a Setup dialog box is displayed asking if you want 
to restore those files from the temporary directory to the new Irma 
directory. 
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7 Do one of the following: 

Choose this option •.• 

Yes 

No 

To .•• 

Move all the saved configuration files 
from the temporary directory to the Irma 
directory. 

Keep all the saved configuration files in 
the temporary directory. You can 
manually move them to the Irma 
directory at a later time. 

The Setup Complete dialog box is displayed. 

8 Do one of the following: 

Choose this option .•• 

Restart PC Now 

Do Not Restart 

To •.. 

Close all your applications and restart 
Windows. 

Continue working with Windows; 
however, you must restart Windows 
before using Irma. 

At this point, the installation is complete. You can skip the next section, and 
tum to "What the Setup program does" on page 3-22. 

Installing for shared access 
Continue reading this section if you chose Shared Access as the Install type. 
Read either "Complete Installation" or "Custom Installation," depending on 
the selection you made earlier in the Setup program. 

Complete installation 

Continue reading this section if you chose Complete Installation. 

1 Do one of the following: 

If ... 

The Setup program detects 
that you already have a 
version of Irma installed. 

Then .•• 

The Save Configuration Files dialog box 
is displayed as shown in Figure 3-8. 
Continue with the next step. 

The Setup program does not Skip to step 3. 
detect that you already have 
a version of Irma installed. 



Figure 3-8. The Save Configuration Files dialog box 

2 Do one of the following: 

Choose this option ••• 

Save 

Don't Save 

To ••• 

Save the selected configuration files. 

Not save any of your previous 
configuration files. 

3 At this point, the Inna files are copied to the destination directory. You are 
prompted to remove each diskette from the drive and insert the next 
diskette. 

Note You can stop the installation process at any time by choosing 
Cancel. 

If you had a previous version of Irma installed, and you selected to save 
your configuration files, a Setup dialog box is displayed asking if you want 
to restore those files from the temporary directory to the new Inna 
directory. 

4 Do one of the following: 

Choose this option ••• 

Yes 

No 

To ••• 

Move all the saved configuration files 
from the temporary directory to the Irma 
directory. 

Keep all the saved configuration files in 
the temporary directory. You can 
manually move them to the Irma 
directory at a later time. 
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The Setup dialog box is displayed, as shown in Figure 3-9. 

'. m 
Setup 

Setup has completed the shared access installation. To setup this 
workstation or any additional client workstations. run the setup 
program from the installation directory. 

Figure 3-9. The Setup dialog box 

5 Choose OK. At this point, the installation is complete. 

Now you are ready to run the Setup program from each workstation. For 
instructions on installing to each workstation, skip to "Attaching a 
workstation to a shared installation" on page 3-18. 

Custom installation 

Continue reading this section if you chose Custom Installation. 

At this point, the Connections dialog box is displayed as shown in 
Figure 3-10. 

Figure 3-10. The Connections dialog box 



The following table describes the options on the Connections dialog box. 

Choose this option ••• 

Standalone or Gateway 

Server Connections 

Add 

Remove 

Add All 

Remove All 

To ••• 

Display the standalone and gateway 
connection types in the Connections 
Chosen list box. 

Display the server connection types in the 
Connections Available list box. 

Move the highlighted connection type 
from the Connection Available list box to 
the Connections Chosen list box. 

Move the highlighted connection type 
from the Connections Chosen list box to 
the Connections Available list box. 

Move all connection types from the Con­
nections Available list box to the Connec­
tions Chosen list box. 

Move all connection types from the Con­
nections Chosen list box to the Connec­
tions Available list box. 

Note You must choose at least one connection type. 

Follow these steps: 

1 Once you have selected your desired connections, choose OK. The 
Applications dialog box is displayed as shown in Figure 3-11. 

Figure 3-11. The Applications dialog box 
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The following table describes the options on the Applications dialog box. 

Choose this option ••• 

Add 

Remove 

Add All 

Remove All 

To ••• 

Move the highlighted application from 
the Applications Available list box to the 
Applications Chosen list box. 

Move the highlighted application from 
the Applications Chosen list box to the 
Applications Available list box. 

Move all applications from the 
Applications Available list box to the 
Applications Chosen list box. 

Move all applications from the 
Applications Chosen list box to the 
Applications Available list box. 

Note You must choose at least one application to install. 

2 Once you have selected your desired applications, choose OK. 

3 Do one of the following: 

H ••• 
The Setup program detects 
that you already have a 
version of Irma installed 

Then ••• 

The Save Configuration Files dialog box 
is displayed as shown in Figure 3-12. 
Continue with the next step. 

The Setup program does not Skip to step 5. 
detect that you already have 
a version of Irma installed 



Figure 3-12. The Save Configuration Files dialog box 

4 Do one of the following: 

Choose this option ... 

Save 

Don't Save 

To ••• 

Save the selected configuration files. 

Not save any of your previous 
configuration files. 

5 At this point, the Irma files are copied to the destination directory. You are 
prompted to remove each diskette from the drive and insert the next 
diskette. 

Note You can stop the installation process at any time by choosing 
Cancel. 

If you had a previous version of Irma installed, and you selected to save 
your configuration files, a Setup dialog box is displayed asking if you want 
to restore those files from the temporary directory to the new Irma 
directory. 

6 Do one of the following: 

Choose this option ••• 

Yes 

No 

Th ••• 

Move all the saved configuration files 
from the temporary directory to the Irma 
directory. 

Keep all the saved configuration files in 
the temporary directory. You can 
manually move them to the Irma 
directory at a later time. 
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The Setup dialog box is displayed, as shown in Figure 3-13 . 

........................................... ::. .... 

ill 
(I 

setup 

Setup has completed the shared access installation. To setup this 
workstation or any additional client workstations. run the setup 
program from the installation directory. 

Figure 3-13. The Setup dialog box 

7 Choose OK. At this point, the installation is complete. 

Now you are ready to run the Setup program from each workstation. For 
instructions on installing to each workstation, read the next section, 
"Attaching a workstation to a shared installation." 

Attaching a workstation to a shared 
installation 

To attach a workstation to the Irma shared installation, follow these steps: 

1 From the workstation that you want to attach, use the Windows File 
Manager and choose the file SETUP.EXE located in the Irma installation 
directory. 

The Irma title screen is displayed. Then the DCA License Agreement is 
displayed. 

2 Read the DCA License Agreement, using the scroll bar to view the text. 



3 When you have finished reading the License Agreement, choose" I have 
read the entire license agreement and I agree." The Welcome dialog box is 
displayed, as shown in Figure 3-14. 

Figure 3-14. The Welcome dialog box 

4 Choose Attach to Software. The Set Private Directory dialog box is 
displayed, as shown in Figure 3-15. 

Figure 3-15. The Set Private Directory dialog box 

5 Specify the private path and choose OK. 

6 At this point, the Irma files are copied to the destination directory. You are 
prompted to remove each diskette from the drive and insert the next 
diskette. . 
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Note You can stop the installation process at any time by choosing 
Cancel. 

When the files have completed copying, the Group Box dialog box is 
displayed. 

7 Do one ofthe following: 

8 

Select this option ••• 

User Defined 

Any program group from 
the list box 

Choose OK. 

To ••• 

Create a new program group containing 
the Irma icons. 

Add the Irma icons to an existing program 
group. 

9 If you selected User Defined, the Name Group Box dialog box is 
displayed. Enter the new group box name and choose OK. You are 
returned to the Group Box dialog box. Then, choose OK. 

The Update System Files dialog box is displayed, as shown in Figure 3-16. 

Figure 3-16. The Update System Files dialog box 



10 Do one of the following: 

Choose this option ••• Th ••• 

Make Changes Automatically change the system files 
AUTOEXEC.BAT, WIN.INI, and 
SYSTEM.INI. We recommend that you 
allow the Setup program make this 
changes for you. 

Save Changes as *.IWW Save the changes to a separate file. You 
must incorporate the changes to the 
individual files manually. The dialog box 
displays recommended changes to the 
AUTOEXEC.BAT file and allows you to 
edit the file. Use the Undo button to undo 
incorrect changes. Once Setup has edited 
the files, it displays the message "Changes 
have been made" and shows you where it 
stores the original files. 

Abandon All Changes Cancel the Setup program. 

Restart Setup Returns to the first screen of the Setup 
program. 

The Setup Complete dialog box is displayed. 

11 Do one of the following: 

Choose this option ••• To ••• 
Restart PC Now Close all your applications and restart 

Windows. 

Do Not Restart Continue working with Windows; 
however, you must restart Windows 
before using Irma. 

At this point, the installation is complete. Continue reading the next section, 
"What the Setup program does." 

it 
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What the Setup program does 
When you install Irma, the Setup program performs the following tasks: 

• Copies the Irma files and directories to the destination directory 

• Creates a program group containing the Irma application icons 

• If you chose to have the Setup program automatically update your system 
files, the following changes are made: 

- The \irma directory is added to the path statement of your 
AUTOEXEC.BAT, where irma is the destination directory you 
specified 

- The following lines are added to your WIN.OO file: 

[InraWOrkStation] 
defaultpath=drive:\Path\3270 
CarpleteRUs=NO 
UsePrint.RSHIJI'D=;NO 

• If you had a previous version of Irma installed, and you chose to save your 
configuration files, a temporary directory named \lWWCFG is created, and 
those selected files are copied to that directory. At the end of the Setup 
program, if you select to restore your configuration files, the files are 
moved from the temporary directory to the Irma installation directory. 

Running Setup after Irma is installed 
After you initially install Irma, you may need to run the Setup program again. 
The options available to you depend on whether you installed Irma as a 
personal copy or as a shared access installation. 
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Personal copy 

If you installed Irma as a personal copy, you can run the Setup program to do 
the following: 

• View the ReadThis.WRI file 

• Add connections or applications 

• Install an option disk 

• Change the host language 

• Deinstall Irma 

• Set up other options including: 

- Update system files 

- Change the name of the Irma program group 

- Save configuration files 

- View current setup 

- Install keyboard driver 

To run the Setup program, choose the Setup icon from the Irma program 
group, and then choose the option that you want to change. 

Shared access 

If you installed Irma for shared access, you can run the Setup program to do 
the following: 

• Update system files 

• Change the name of the Irma program group 

• Save configuration files 

• View current setup 

• Install keyboard driver 

• Attach to the shared access installation 

To run the Setup program, choose the Setup icon from the Irma program 
group, and then choose the option that you want to change. 
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Summary 
In this chapter, you learned the following: 

o How to install Irma using either the Personal Copy or the Shared 
Access installation types 

o What the Setup program does 

o How you can run the Setup program after the initial installation 

Before you can use any of the installed connectivities, you must configure 
each connection. All the information about configuring, customizing, and 
using the Irma connectivities is contained in online help. Therefore, it is very 
important that you understand how the Irma online help works and how to 
find the information you need. 

Now turn to Chapter 4, "How Online Help Works," to learn how to use the 
Irma online help. 
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How Online Help 
Works 

• Why use online help? 

• What if you're new to online help? 

• How do you access online help? 

• Online help tutorial 

• Summary 

4-2 

4-2 

4-5 

4-6 

4-9 
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2 ¥'CompletfJ your planning 
cilecklist 

:3 ¥'install Irma 

Learn about online help 

Configure the connection and 
start a communications session 

Customize your session 

Why use online help? 

If you haven't used online help 
before, don't worry. This chapter 
will teach you how to access online 
help from a dialog box and by using 
the Help menu. You'll also learn how 
to use each of the Help buttons and 
how to search for a topic. 

Even if you're familiar with using 
online help in other products, take a 
few minutes to scan this chapter so 
you'll understand how the Irma 
online help works. 

You'll need about 15 minutes to 
read this chapter and complete the 
online help tutorial. 

It is very important that you are comfortable working with the Irma online 
help because it contains the information you need to configure, use, and 
customize Irma. 

What if you're new to online help? 
If you haven't used online help before, take a few minutes to become familiar 
with the features described in this section. 

When you access online help, you'll see a window similar to the one in 
Figure 4-1. 



Glick any of the following topics for overview and 
introductory information 

Q:Y..~.Li.~'!t.. .. Q.LJ.tlQ. .. MJil.[!J1Lq,ID..sLD1~p-La~~ 

AI~Q.!,.jJl.b.~ ... M:;aj.njJa!JJ.~.DLsp.l.aY ... Qn.J.Ln~.JJ~J.p 
M~iD.f.r.?m.e Q[~pl;;J,y.m.~.n\.ls 

Th.fiL.QuickB21.s. 
The statLis lin(~ 

What is new in this versiOIl 

Using the eCA Connection BBS. 

Figure 4-1. Example of a Help window 

Table 4-1 describes the Help window features. 

Table 4-1. Help window features 

Feature 
Jumps 

Example Description 
The status line When you see text that is underlined 

with a solid line, it means that the text 
is linked to another piece of 
information. When you move the 
pointer over the underlined text, the 
pointer changes to a pointing hand. 
Click once on the underlined text to 
"jump" to the related information. To 
move back to the original help topic, 
choose Back from the button bar. 
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Table 4-1. 

Feature 

Popup 
boxes 

Contents 
button 

Search 
button 

Back 
button 

History 
button 

Glossary 
button 

Support 
button 

Help window features (cont.) 

Example Description 

r~t"'!D.fJ",n,-""Jil~pj;;w-When you see text that is underlined 
with a dotted line, it means that the text 
is linked to another piece of 
information. When you move the 
pOinter over the underlined text, the 
pOinter changes to a pointing hand. 
Click once on the underlined text to 
displayed a pop-up box containing the 
related information. To close the pop­
up box, click once anywhere on the 
screen. 

111111111 

111I11a' 

This button displays the help contents 
for the application. This contents page 
is organized much like a table of 
contents in a book. If you're new to an 
application, you can start with 
"Introducing" and move on to the other 
major topics, just as you would move 
through a book. 

This button displays the Search dialog 
box, which allows you to search for 
keywords in the online help. 

This button takes you back to the 
previous help panel. 

This button displays the names of the 
help panels in the order in which you 
have accessed them. 

This button displays a glossary of 
terms used in the application. 

This button displays a Write file 
containing information about 
contacting DCA Technical Services. 

For complete information about using Windows online help, including how to 
print help panels, do the following: 

• Choose Using Windows Help from the Help menu of any window. 

or 

• Open any Help window and press (fD. 

or 

• Open any Help window and choose Using Help from the Help menu. 
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How do you access online help? 
Table 4-2 explains the two ways to access online help. 

Table 4-2. Ways to access online help 

You can access online 
help by ... 
Clicking on the Help 
button in a dialog box. 

Choosing Help from 
the menu bar. 

The information you see is ... 
Detailed information about the dialog 
box, including information for each 
entry field or selection. 

Help that is organized much like a 
book, including a contents panel. You 
can search the entire help file for the 
information you want. The help file 
also includes a glossary. 

iI-Once you have accessed online help, you can resize, move, maximize, and _ 
minimize the Help window, just as you can any other window. If you see a 
scroll bar on the right side of the Help window, be sure to scroll down to see Chapter 4 

all the information for a help topic. 

The following sections explain how to access online help using both methods. 

Choosing the Help button from a dialog box 

Most dialog boxes that require you to enter information or to make choices 
contain a Help button. For assistance with completing the fields or making 
selections, simply click the Help button. The Help window is displayed with 
information about the dialog box, including the entry fields and other 
selections. 

To close the Help window, choose Exit from the File menu. 
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Choosing help from the menu bar 

You can access online help anytime by choosing one of the topics from the 
Help menu. The menu selections are described in Table 4-3. 

Table 4-3. Help menu selections 

Selection 

Help for application 

Using Windows help 

Contents 

Description 

This selection opens the Help window and 
displays a panel that introduces the 
application. 

This selection opens the Help window and 
displays general information about how to 
use online help. 

This selection opens the Help window and 
displays the contents panel for the 
application's online help. 

Online help tutorial 
Follow these steps to learn how to access, search, and navigate through the 
Irma online help. 

Lesson 1: Using the Help button in a dialog 
box 

1 Start the Mainframe Sessions application by choosing the Mainframe 
Sessions icon. You don't need to activate a host session to complete the 
online help tutorial. 

2 Choose Preferences from the Settings menu. The Preferences dialog box 
is displayed. 

3 Click the Help button. The Help window is opened, and it displays 
information about the Preferences dialog box. 

ttl You just accessed online help using a dialog box Help button. 

4 If necessary, use the scroll bars so that you can see the Related Topics at 
the bottom on the help panel. 

5 Click the green text "Using shortcut keys" to jump to information about 
shortcut keys. 

ttl You just learned how to "jump" from one topic to another. 
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6 Close the Help window by choosing Exit from the File menu. 

7 Choose Cancel to close the Preferences dialog box. 

Lesson 2: Using the Help menu option 

1 Choose Help for Mainframe Display from the Help menu. The Help 
window is opened, and it displays the help topic "Introducing Mainframe 
Display." 

II' You just accessed online help using the Help menu. 

2 Click the text "Mainframe Display menus." A pop-up box displays a list 
of jumps. 

3 To close the pop-up box, click anywhere on the screen. 

4 

II' You just learned how to display and close a pop-up box. 

Choose Contents from the button bar. The help topic "Help Contents for 
Mainframe Display" is displayed. 

II' You just learned how to navigate to the Contents panel. 

S Click the text "Getting Started." The "Getting Started" help topic is 
displayed. 

6 Click the text "Selecting your connection." The "Selecting your 
connection" help topic is displayed. 

7 Choose Back from the button bar. The previous help topic ("Getting 
Started") is displayed. 

8 Choose Back from the button bar. The previous help topic ("Help Contents 
for Mainframe Display") is displayed. 

II' You just learned how to display previous panels using the Back button. 

9 Choose Search from the button bar. The Search dialog box is displayed. 

10 Enter the word "QuickBar." As you type, the upper list box displays 
keywords that match what you are entering. 

11 When the word "QuickBar" is highlighted, click Show Topics. A list of 
related topics is displayed in the lower list box. 

12 Select "Customizing your QuickBar," and click Go To. The "Customizing 
your QuickBar" topic is displayed. 

II' You just learned how to find a help topic using the search feature. 

13 Close the Help window by choosing Exit from the File menu. 
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Lesson 3: Using the Glossary and Support 
buttons 

1 

2 

3 

4 

5 

6 

7 

Choose Contents from the Help menu. 

Choose Glossary from the button Bar. The Glossary window is opened, 
and it displays the glossary contents. 

Click the letter "L." The contents list scrolls to the letter L. 

Scroll down until you see the text "LV" and click the text. A definition for 
LV is displayed in a pop-up box. 

To close the pop-up box, click anywhere on the screen. 

To close the Glossary window, choose Close from the Control menu (the 
left-most icon in the title bar). 

V You just learned how to use the glossary feature. 

If you have a question, and you cannot find the answer in this guide or in 
the online help, you may want to contact DCA Technical Services. To find 
out more information about troubleshooting and contacting Technical 
Services, choose Support from the button bar. A Write file is displayed 
with information about troubleshooting and contacting Technical 
Services. 

Note You can also you can refer to Appendix A, "Troubleshooting," for 
information about contacting DCA Technical Services. 

8 To close the Write window, choose Exit from the File menu. 

V You just learned how to access troubleshooting and Technical Services 
information. 

That's all there is to using the Irma online help. You should now feel 
comfortable in accessing the information you need to configure, use, and 
customize Irma. 
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Summary 
In this chapter, you learned the following: 

o How to access online help from a dialog box and the Help menu 

o What each of the Help buttons does 

o How to search the online help for a keyword 

Now that you know how to use the Irma online help, tum to Chapter 5, 
"Finishing Up the Task List," which tells you where to go from here to 
complete the remaining tasks on the task list. 
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Finishing Up the 
Task List 

• Configuring the connection and starting a 
communications session 

• Customizing your session 

• Developing your own applications 

• Summary 
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Configure the connection 
and start a communications 
session 

Customize your session 

In this chapter, you'll complete Task 5, 
"Configuring the connection and starting a 
communication session." This chapter 
also tells you how to get additional 
information from online help to assist you 
with Task 6, "Customizing your session." 

In addition, this chapter describes the 
application tools available for Irma. 

You'll need about 10 minutes to read this 
chapter. 

Configuring the connection and 
starting a communications session 

Task 5 on the Task List is "Configure the connection and start a 
communications session." This section explains how to do this task. 

To configure a mainframe connection, follow these steps: 

1 Start the Mainframe Sessions application by clicking the Mainframe 
Sessions icon. The Select Connection dialog box is displayed. 

As an example, a Select Connection dialog box with only the 802.2 
connection installed is shown in Figure 5-1. 



Figure 5-1. The Select Connection dialog box 

2 Select the connection type you want to use and choose Select. The 
Configuration Options dialog box is displayed as shown in Figure 5-2. 

Figure 5-2. The Configuration Options 
dialog box 

3 Choose Connection. A Connection dialog box is displayed with entry 
fields for the selected connection type. For assistance with completing this 
dialog box, click Help. 

As an example, the Token-Ring Connection dialog box is shown in 
Figure 5-3. 
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Token Ring Connection 

Name Description 

Factor Defaults 

Change 

]2elele ... 

CQ.nnection Name: ITR 
DJ;tscription: r-I --------

Node 10 10 Send: ~ . I FFFFF 

Node 1010 Receiy'e: I· I I~IO Type········ 

:::::1;::::;':::5: i-~-oo-o-oo-oo:"'o-oo-o--- I ....... ~ .. ;;:;::.; .... . 
OK I I Cancel I I F,aming... I I liNAm I II.........;;H;;;,.e..:.IP_..J 

Figure 5-3. The Token Ring Connection dialog box 

4 Some connection types have additional dialog boxes that are accessed by 
choosing buttons on the Connection dialog box. Be sure to enter the 
required information in all the dialog boxes. 

For example, the Token-Ring Connection dialog box, shown in 
Figure 5-3, has two buttons named Framing and SNA. If you click either 
of these buttons, another dialog box is displayed. 

5 When you have entered all the information in the Connection dialog 
box(es), choose OK. The Select Connection dialog box is displayed. 

6 Choose Select to make the newly configured connection the active 
connection. The Start Sessions dialog box is displayed, as shown in 
Figure 5-4. 



- Start Sessions 

liession 10 and Description . . . . . 
B - Token Ring Session B 
C - Token Ring Session C 
0- Token Ring Session 0 

,Startup Display Type------

@ Modl C Modl 
C Mod 5.___ _________________ .1 

OMod1 

! ................................................................. -..... . 

IX Auto Connect Session Startup Script: I 

Start Cancel lielp 

Figure 5-4. The Start Sessions dialog box 

7 Select the Session you want to start and the Startup Display Type. If 
desired, choose Auto Connect Session and specify a Startup Script. 

For assistance with completing the fields in this dialog box, choose Help. 

8 Choose Start to start the session. 
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Customizing your session 
Task 6 on the Task List is "Customize your session." All the information you 
need to do this task is contained in the online help. 

To find the information you want: 

1 Choose Contents from the Help menu. The Help window is opened, and it 
displays the "Contents" topic. 

2 Do one of the following: 

To... Do this .•. 
See a list of related topics Choose the Topic "Using the application," 

where application refers to the application 
you are currently running. 

Search for a topic Choose Search from the button bar and 
search for a topic based on a keyword. 

Refer to Chapter 4, "How Online Help Works," for assistance with using 
online help. 

Developing your own applications 
As you use Irma, you may decide that you want to automate common tasks. 
There are several tools that can help you develop your own applications that 
work with Irma. Each tool is described in Table 5-1. 

Table 5-1. Development tools 

Development 
tool 
Standard Irma 
Script 
Language 
(SISL) 

Description 
Irma offers enhanced scripting capabilities with the 
Standard Irma Script Language (SISL). For example, 
you can use SISL to automate file transfers, start and 
control applications, access a mainframe database, and 
retrieve and move information. You use the QuickScript 
application that is included with Irma to create, edit, 
compile, and run the SISL scripts. 

Full support for SISL is included in the Mainframe 
Sessions application. Instructions for using SISL and 
QuickScript are contained in the QuickScript online help. 



Table 5-1. Development tools (cont.) 

Development 
tool 
QuickApp ™ for 
Windows 

Distributed 
Applications 
Developer's 
Tool Kit 

HLLAPI 
Software 
Developer's 
Tool Kit 

Summary 

Description 
DCA offers a product, QuickApp for Windows, that is a 
middle-ware communications development tool for 
developing client/server applications. QuickApp requires 
Visual Basic™, Visual C++TM, PowerBuilder™, 
SQLWindows®, or ObjectVieW®. You can use QuickApp 
with Irma to develop graphical front-end interfaces for 
legacy host applications. 

For more information, or to order QuickApp for Windows, 
contact DCA Sales Operations at 1-800-348-3221. 

To develop your own applications using APPC, CPI-C. 
LUA, or CSV, you must have this tool kit. 

To order the tool kit, call Developer Services at (404) 
740-0001. 

To develop your own applications using HLLAPI, you 
must have this tool kit. 

To order the tool kit, call Developer Services at (404) 
740-0001. 

In this chapter, you learned the following: 

o How to configure a connection and start a session 

o Where you can find information to help you customize your sessions 

o The development tools available for Irma 

We hope you found this Getting Started Guide to be helpful. We welcome 
your comments so that we can continue to improve our documentation. Please 
use the Comment Card located in the back of this guide to give us your ideas 
and suggestions. 

There are also electronic Comment Cards included in the online help for each 
application. Choose "What Do You Think" from the Contents panel to access 
the online Comment Card. 
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General troubleshooting procedures 
If you have problems running your Irma software, complete the following 
steps: 

1 Check to see that your system meets the minimum hardware and 
software requirements necessary to use the product. Refer to the 
hardware and software requirements earlier in this guide for this 
information. 

2 Check the configuration options. Most problems are caused by incorrect 
software configuration. Check to make sure you have selected the correct 
configuration options. 

3 Check your connections. Check your cable connections and make sure 
that they are securely attached. 

4 Check your system. You may be using peripheral equipment or other 
software that may not be compatible with this product. Try disabling some 
of the other memory-resident programs. 

5 Resolve errors. If you are receiving error messages, click Troubleshoot­
ing from the Help Contents for help resolving these messages. 

6 Check the DCA BBS. Check the DCA BBS for tech tips or hot fixes that 
may solve your problem. 

7 Consult your distributor. If you cannot identify and solve the problem 
without assistance, conta~t your product distributor. Call from a location 
where you have access to the problem Pc. 

B Contact DCA technical support. Refer to the following sections, 
"Contacting Technical Support" and "Technical Support Information 
Sheet," for more information. 

Contacting Technical Support 
Every product package that you purchase from DCA comes with a Standard 
level of technical support as a part of our SupportWorks technical services 
program. SupportWorks Standard provides access to technical support 
through our Technical Services Group CTSG) by phone or through electronic 
means. 

Note The Standard SupportWorks program offerings vary from country to country. 
The information provided here is for the United States and Canada. For 
International Support Services, contact your local DCA distributor, DCA 
account representative, or TSG for details. 



Phone access for registered users 

In the United States and Canada, SupportWorks Standard support provides i1 
the following phone service to registered users from 9 A.M. to 8 P.M. Eastern 
Time, Monday through Friday, excluding DCA holidays: 

• Complimentary technical support from DCA for 90 days calculated from 
the day of your first call 

Note After the 90 days have expired, you can call TSG for a minimal 
fee, which will be applied to your credit card (Master Card, VISA, 
or American Express). 

• An estimated 4-hour response time from a technical support analyst 

Note The SupportWorks offerings vary from country to country. The 
information provided here is for the United States and Canada. For 
International Support Services, contact your local DCA distributor, 
DCA account representative, or TSG for details. 

Support hotlines 

Our support hotlines follow: 

United States, Canada, and Latin America (404) 740-0300 
Asia (65) 291-7988 
Australia (61) (2) 451-8255 
Europe +353 61-472111 
Japan (81) (3) 5275-0130 

Before you call 

Before contacting TSG by phone, complete the following items in 
preparation-it will help us to resolve your problem more quickly and 
efficiently. 

• If possible, when you call, be at the computer with the DCA product 
installed and connected, the computer on, and the software loaded. 

• Complete the "Technical Support Information Sheet" located in the 
following section. 
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Electronic access for registered users 

You can contact TSG electronically by fax, BBS, or public electronic mail 
services. DCA will endeavor to respond by the next business day to issues 
submitted electronically, and this service is available during and after your 
standard 90 days of support service. 

FAX access 

The fax numbers are as follows: 

United States, Canada, and Latin America (404) 442-4358 
Asia (65) 291-9281 
Australia (61) (2) 451-4034 
Europe +35361-474002 
Japan (81) (3) 5275-0755 

Using the "Technical Support Information Sheet," you can fax your question 
or problem directly to TSG. 

BBS access in the United States and Canada 

(404) 740-8428 

Registration on the DCA BBS is free. All you need is an asychronous modem 
and asynchronous communication software, such as DCA Crosstalk®. Set 
your communication software parameters for BBS access as follows: 

Parameter Setting 
Data bits 8 

Parity None 

Stop bits 1 

Speed 1200 or higher 

Emulation ANSI or TTY 



BBS access in Europe, Africa, and the Middle East 

353 61 474460 353 61 474246 
(If you have modem compatibility problems 
with the first number, try this number.) 

Registration on the DCA BBS is free. All you need is an asychronous modem 
and asynchronous communication software, such as DCA Crosstalk. Set your 
communication software parameters for BBS access as follows: 

Parameter Setting 
Data bits 8 

Parity None 

Stop bits 1 

Speed 1200 or higher 

If the following options are available in your asynchronous communications 
software, use these values: 

Option Value 
Flow Control RTSCTS 

Terminal ANSI 

File Transfer Zmodem 

Using the DCA BBS 

As a new user (the first time you dial the BBS), you are required to enter a 
user name and password of your choice. If you forget either your user name 
or password, call TSG to provide required information to access the BBS. 
New users have the right to view all files on the DCA BBS that are not 
password-protected, such as product tech tips, README files, frequently 
asked questions, and utilities. 

You can upgrade your rights by contacting TSG. For instance, you may want 
to be able to upload and download files from several conferences. You can 
also access software as well as text files. 

Tips for using the DCA BBS 

• DCA uses the PK(UN)ZIP.EXE programs to compact files on the BBS in 
order to conserve space and optimize the time you spend downloading 
files. If you do not have these programs, you can download both programs 
from the BBS. 
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• Compact your disks when uploading using the PKZIP.EXE program to 
optimize the time you spend on the BBS. 

• If you know the file that.you want to download, you can download the file 
without knowing where it is. When you access the File Downloads area, 
enter the name exactly as you have received it and proceed with the 
download process. 

• If you have problems connecting to the DCA BBS, check your modem 
settings first. 

• If you receive a busy signal consistently when you are trying to connect to 
the BBS, your modem may be configured incorrectly. Check your modem 
configuration. If the problem persists, contact TSG for assistance. 

• If the BBS number you are dialing does not answer, check your modem 
configuration. If the problem persists, contact TSG for assistance. 

When submitting an issue electronically, be sure to include all the information 
on the "Technical Support Information Sheet" in the following section. 

Internet and CompuServe access 

To find out how to contact us through the Internet or CompuServe™, call 
your local support hotline. 

Other technical support options 

More comprehensive technical support packages are available from DCA. 
The SupportWorks technical support services programs offer a wide range of 
base (complimentary) services in addition to several tiers of expanded 
services designed to help you implement and maintain your DCA products 
most effectively. In the United States and Canada, these programs provide 
extensive coverage, such as: 

• Fifteen-minute to 2-hour response times 

• Toll-free telephone access 

• Walk-through installations 

• On-site visits from Senior Support Analysts 

If you are located in the United States, Canada, or Latin America, call your 
account representative at (800) 348-3221 and ask about Standard, Classic, 
Enhanced, and Premium SupportWorks offerings for more information. 

A-6 Contacting Tecfmicai Support 



Note The SupportWorks offerings vary from country to country. The information 
provided here is for the United States and Canada. For International Support 
Services, contact your local DCA distributor, DCA account representative, or 
TSG for details. 

Obtaining product information through the DCA FAX 
Connection 

(404) 442-4035 

You can access the DCA FAX Connection to obtain current information about 
all of DCA's product offerings, including pricing, technical tips, and general 
product information. Simply call the number and you will be electronically 
guided through the system. During the process, you must provide a fax 
number to designate where to send the requested documents. 
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Technical support information sheet 
When contacting TSG by phone or by electronic means, be prepared to 
provide the information described here: 

Information 
requested 
Product and 
version number 

Connectivity type 

Gateway/server 

Transport 

Transport vendor 

Transport version 

Error number and 
message 

Problem 
description 

Steps to 
reproduce the 
problem 

Example Your entry 
Irma Suite 3.0 

Mainframe 

Modem 

NetWare for SAA 

IPX 

Novell 

3.10 

NOV162-TCPIP 
connection fail 



Please provide the following reports based on the type of problem that is 
occurring: 

Problem type 

General protection fault 

Connection or link failure 

Installation or 
configuration error 

Agent installation error 

Script error 

Transport error 

Other errors 

Report requested 

MSD report and Dr. Watson report. 

Trace of communications activity and 
system log. 

Printed configuration file and system log. 

Agent's MSD report, Agent's 
WSAGENT.LOG, and *.INI file listing 
from Agent installation media. 

Script and Agent's WSAGENT.LOG. 

MSD report. 

MSD report. 

Obtaining product upgrades 
DCA periodically updates its software to add features or to correct reported 
problems. If you are covered under the DCAdvantage Upgrade Maintenance 
Plan, all of these releases will be sent to you automatically. If you are not 
covered, you may be required to purchase product upgrades if you desire. 

For more information regarding the annual DCAdvantage Upgrade 
Maintenance Plan, or for one-time product upgrades, contact your local DCA 
account representative. 

Replacing software disks 
To receive a replacement disk during the warranty period, contact DCA TSG 
in the United States or your international distributor. If you are calling DCA, 
ask to speak to a technical support analyst who will verify the problem and 
arrange to replace the disk, if necessary. Return the disk, postage prepaid, by 
means of a traceable carrier, to DCA at one of the addresses shown here. 
DCA does not accept disks that have been sent C.O.D. In addition, you must 
insure any item being returned to DCA. DCA is not responsible for any items 
lost or damaged in transit. 
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Address 

United States and Canadian customers should mail the disk, postage prepaid, 
to the following address: 

Digital Communications Associates, Inc. 
Technical Services Group 
1000 Alderman Drive 
Alpharetta, GA 30202-4199 

Customers outside the United States and Canada should contact their dealers 
or distributors to replace a disk. 

Replacement disks are shipped by a method of DCA's choosing. If you desire 
a different shipping method, or are located outside the United States, you 
must bear the cost of shipment. Please use a street address as a return address; 
DCA does not ship items to a Post Office box. 

Returning hardware or software 
If for any reason you need to return a DCA product, use the Return Form 
included in your package. If you are returning an evaluation or product for 
credit, call your DCA account representative 1-800-348-3221 to obtain an 
RM# (return of merchandise number). 

If you cannot locate the Return Form, used the procedure and form provided 
here. 

Hardware return information 

If you believe you have a hardware problem, please call DCA TSG or your 
international distributor or dealer before you remove or disconnect your DCA 
product. You may be asked to perform some diagnostics that require you to 
leave the unit installed to determine the nature of the problem. 

There is no charge for the repair or replacement of hardware under warranty. 
DCA will repair units not under warranty at the prevailing rates. If the 
hardware is not under warranty and there is a charge, DCA requires a hard­
copy purchase order, a letter of intent to pay, or a charge card number (Visa, 
Master Card, or American Express). Contact TSG for further details. 
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Returning hardware for repair, an evaluation product, or 
a product for credit 

The following procedure explains how to return hardware for repair, return an 
evaluation product, or return a product for credit: 

1 If you are calling from the United States or Canada, call your DCA account 
representative at 1-800-348-3 221 to obtain an RM # (return of merchandise 
number). 

If you are calling from anywhere outside of United States or Canada, 
contact your international distributor or dealer to obtain an RM#. 

For Hardware Returns: If you are returning hardware, have your product 
serial number on hand when you call. 

2 Copy and then complete the DCA Return Form located in the next section. 

3 If possible, pack the hardware or software in its original container. If the 
original container is unavailable, be sure to wrap hardware in non-static 
material such as newspaper and pack it in a sturdy, cardboard container. 

Note If you are returning hardware for repair, return only the unit; do not 
return accessories, such as cables, disks, or documentation, 
unless otherwise instructed. 

4 Insert the completed DCA Return Form on top of the hardware or software 
inside the box before sealing. 

S If you are mailing from the United States or Canada, mail the unit by 
prepaid postage, by means of a traceable carrier, to the following address: 

Digital Communications Associates, Inc. 
Attention: RM# ____ _ 
1000 Alderman Drive 
Alpharetta, GA 30202-4199 

Customers outside the United States and Canada should mail the package, 
postage prepaid, by means of a traceable carrier, to their distributors. 

Note DCA does not accept packages that have been sent C.O.D., nor 
do we accept packages that lack an RM# clearly marked on the 
address of the package, excluding a product being returned for 
exchange (see the next section, "Returning a product for 
exchange"). 
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Returning a product for exchange 

If you are returning a product for exchange, follow this procedure: 

1 Copy and then complete the DCA Return Form located in the next section. 

2 If possible, pack the hardware or software in its original container. If the 
original container is unavailable, be sure to wrap hardware in non-static 
material such as newspaper and pack it in a sturdy, cardboard container. 

Note If you are retuming hardware for repair, retum only the unit; do not 
retum accessories, such as cables, disks, or documentation, 
unless otherwise instructed. 

3 Insert the completed DCA Return Form on top of the hardware or software 
inside the box before sealing. 

4 If you are mailing from the United States or Canada, mail the unit by 
prepaid postage, by means of a traceable carrier, to the following address: 

Digital Communications Associates, Inc. 
Attention: Product for Exchange 
1000 Alderman Drive 
Alpharetta, GA 30202-4199 

Customers outside the United States and Canada should mail the package, 
postage prepaid, by means of a traceable carrier, to their distributors. 

Note DCA does not accept packages that have been sent C.O.D. 



DCA return form 
Check one of the following: 

Returning product for credit 

Returning an evaluation unit 
for credit 

Returning product for 
exchange 

Returning hardware unit for 
repair 

RM# (not required for 
exchanges) 

Date 

Contact name 

Phone 

Address 

Customer Identification 
number 

Purchase order number 

DCA contact name 

Product name 

Product version 

Serial number (if applicable) 

Reason for return 

Place of purchase 

Date of purchase 
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autosizing of fonts, 1-7 

B 
Back button, 4-4 

C 
.CCF (style file extension), 1-15 
Chameleon, 1-5 
checklists 

gateway connections, 2-12 
mainframe connectivity (custom), 

2-13 

checklists (cont.) 
overview, 2-10 
Select Comm Server, 2-14 
server connections, 2-12 
standalone connection, 2 -12 
TN3270 connection, 2-11 

colors, 1-10, 1-15 
Common Programming Interface 

Communications (CPI-C), 1-7 
Common Service Verbs (CSV), 1-7 
communications adapters, 2-5 
Configurator ( application), 1-12 
connections 

adding, 1-14, 3-23 
configuring, 1-11 

Contents button, 4-4 
contents, package, 2-2 
Country Extended Code Page (CECP), 1-7 
CPI-C,1-13 
CUT 

D 

support for, 1-4 
supported adapters, 2-5 

DCA Distributed Applications 
Developer's Tool Kit, 1-13, 5-7 

DCA Synchronous Communications 
Adapter, 2-5 

deinstallation, 3-23 
DFT 

support for, 1-4 
supported adapters, 2-5 

diagnostics, 1-7 
accessing in Irma Suite, 1-13 
log files, 1-16 

Diagnostics (application), 1-12 
dialog boxes, help for, 4-5 
Digital SNA Gateway, 1-5, 2-7 
diskettes 

contents, 2-2 
Irma Graphics for Windows, 2-3 
optional, 2-3 

display profile, 1-15 
display sessions 

automatically activating, 1-15 
customizing, 1-10 
supported models, 1-10 

documentation conventions, xii 



drag-and-drop, 1-9 
Dynamic Data Exchange (DDE), 1-7 

E 
Elll..LAPI, 1-7 
Eicon SNA Gateway 

checklist, 2-13 
mainframe connectivity, 1-5, 2-7 

.EMU (display profile extension), 1-15 
Ethernet, 1-4 
Extended Attribute Byte (EAB), 1-7 

F 
features 

files 

list of, 1-7 
new with this version, 1-11 

log, 1-16 
screen capture, 1-16 
trace, 1-16 
using existing configuration files, 

2-10 
file transfer, 1-7, 1-15 
font mapping, 1-8 
fonts 

autosizing, 1-7 
selecting, 1-10 
stored in profile, 1-15 
TrueType, 1-7 

Frontier Super TCPINFS 
mainframe connectivity, 2-9 

.FT (file transfer profile extension), 1-15 
FTlExpress, 1-7, 2-6 

G 
gateway connections checklist, 2-12 
Glossary button, 4-4 
graphics, 1-7, 2-3 

H 
hardware requirements, 2-3 
help. See online help 
History button, 4-4 
lll..LAPI Software Developer's Tool Kit, 

5-7 
host language, 1-14, 3-23 

2 index 

host screens 
capturing, 1-10 
copying and pasting text, 

1-10 
HP-UX SNApius Server, 1-6, 2-8 

mM LAN Support Program, 2-5 
mM Multiprotocol Communications 

Adapter/A,2-5 
mM 122-key keyboards, 1-8 
mM SDLC Adapter, 2-5 
mM 3270 Connection Adapter, 2-5 
mM 3278179 Emulation Adapter, 2-5 
mM Token-Ring Adapter, 2-5 
icons 

program group, 1-11 
QuickBar, 1-9 
that were in IRMA WorkStation for 

Windows, 1-11 
IND$FlLE, 1-7, 1-9 
installation 

checklists, 2-10 
deinstalling, 3-23 
hardware requirements, 2-3 
upgrading from a previous version, 

2-9 
using existing configuration files and 

profiles, 2-10 
Irma Graphics for Windows 

ordering, 2-3 
support for, 1-7 

IrmaK.ey/3270, 1-8 
IrmaLAN, support for, 1-5 
IrmaLAN Gateway, 2-7 
IrmaLAN for VlNES Gateway, 2-7 
IrmaLink, 1-7, 1-9 
Irma 2, 2-5 
Irma 3,2-5 
IRMA WorkStation for Windows, 1-11 
.ISL (SISL source file extension), 1-15 
.ISX (SISL compiled file extension), 1-15 

J 
jumps, 4-3 



K 
.KBD (keyboard profile extension), 1-15 
keyboard 

changing the driver, 1-14 
editing, 1-13 
selecting, 1-13 
supported, 1-8 

keyboard editor, 1-8 
Keyboard Editor (application), 1-12 
keyboard mapping, 1-15 
keyboard profile, 1-15 
Key Tronic, 1-8 

L 
LAN Manager 

mainframe connectivity, 2-9 
used with TN3270, 2-5 

leased lines, 1-4 
light pen, 1-8 
.LOG (log file extension), 1-16 
log files, 1-16 
LU 6.2,2-6 
LUA,1-8 

M 
MacData 6100, 2-9 
macros 

assigning to a keyboard, 1-8 
description of, 1-8 

Madge Token-Ring Adapter, 2-5 
mainframe connections 

configuring, 5-2 
starting, 5 -2 

mainframe connectivity, checklist for 
custom installation, 2 -13 

mainframe display, 1-13 
mainframe printer, 1-13 
mainframe sessions 

configuring, 1-13 
customizing, 5-6 

Mainframe Sessions (application), 1-13 
McData 6100/6200, 1-8 
Memorex-Telex, 1-8 
Microdyne IrmaTrac Convertible Token­

Ring Adapter, 2-5 
Microsoft Office, 1-8 
Microsoft Windows, 2-6 

models, 1-10 
Multiple document interface (MDI), 1-8 

N 
NetView, 1-8 
NetWare, 1-5 
NetWare for SAA, 1-6 
Netway 2000 Gateway, 1-6, 2-7 
Novell LAN WorkPlace 

mainframe connectivity, 2-9 
used with TN3270, 2-5 

Novell NetWare for SAA, 2-8 

o 
online help 

accessing from a dialog box, 4-5 
accessing from the menu bar, 4-6 
Back button, 4-4 
Contents button, 4-4 
example of a help window, 4-3 
getting more information, 4-4 
Glossary button, 4-4 
History button, 4-4 
jumps, 4-3 
pop-up boxes, 4-4 
Search button, 4-4 
Support button, 4-4 
tutorial, 4-6 

OpenConnect Server, 2-9 
OpenConnect System (OCS), 1-8 
option disk, installing, 1-14 

p 
Pathways SDLC Adapter, 2-5 
PATHWORKS 

mainframe connectivity, 2-7, 2-9 
used with Digital SNA Gatway, 1-5 
used with TN3270, 1-5, 2-5 

PC-NFS 
mainframe connectivity, 2-9 
support for, 2-5 
used with TN3270, 1-5 

pop-up boxes, 4-4 
printer profile, 1-16 
printing host screens, 1-1 ° 



profiles 
definition of, 1-9 
display, 1-15 
file transfer, 1-15 
keyboard, 1-15 
printer, 1-16 
QuickExec, 1-16 
QuickPad, 1-16 
using existing profiles, 2-10 

program group, changing the name, 1-14 
Programmed Symbols (PS), 1-7 
Proteon Token-Ring Adapter, 2-5 
.PRT (printer profile extension), 1-16 
PS/CICS, 1-7 

Q 
.QBD (QuickPad profile extension), 1-16 
.QEP (QuickExec profile extension), 1-16 
QuickApp, 5-7 
QuickBar, 1-9 
QuickDDE,1-9 
QuickExec (application) 

how to start, 1-13 
icon in previous version, 1-12 
overview of, 1-9 
profile, 1-16 

QuickHit, 1-9 
QuickPad, 1-8, 1-9 
QuickPad profile, 1-16 
QuickSAA,1-9 
QuickScript (application) 

how to start, 1-13 
icon in previous version, 1-12 
overview of, 1-9 

QuickSend,1-9 

R 
Read This (file), 1-14 
READTHIS.WRI, 3-2, 3-23 
Response Time Monitor (RTM), 1-9 

S 
.SCR(screen capture extension), 1-16 
screen captures 

file extension, 1-16 
support for, 1-10 

Script Editor, 1-10 

4 imjex 

scripts 
assigning to a keyboard, 1-8 
support for, 1-10 

SDLC 
support for, 1-4 
supported adapters, 2-5 

Search button, 4-4 
Select Comm Server 

checklist, 2-14 
mainframe connectivity, 1-6 
software requirements, 2-8 

serial port, 1-10 
server connections checklist, 2-12 
session window, resizing, 1-7 
Setup (application), 1-14 
SiemenslNixdoft 122-key, 1-8 
SISL 

compiled file, 1-15 
ordering documentation, 5-6 
source file, 1-15 
support for, 1-10 

SNAP-IX 
support for, 1-6 
used with TN3270, 1-5 

SNAServer 
mainframe connectivity, 1-6 
software requirements, 2-8 

software, ordering optional, 2-3 
software requirements, 2-6 
standalone connection checklist, 2 -12 
style file, 1-15 
Support button, 4-4 
switched lines, 1-4 
synchronous modem, 1-4 

T 
tables, copying and pasting, 1-10 
task list, explanation of, x 
TCPIIP,1-5 
text, copying and pasting, 1-10 
3Com, 2-5, 2-9 
TN3270 

checklist, 2 -11 
software requirements, 2-9 
supported adapters, 2-5 
support for, 1-5 

TN3279 printing, 1-8 
token-ring, 1-4 



trace files, 1-16 
.TRC (trace file extension), 1-16 
TrueType fonts, 1-7 
tutorial for online help, 4-6 

U 
user alerts, 1-8 

V 
VINES, 1-5 
VTAM,2-6 

W 
Walker Richer & Quinn 

mainframe connectivity, 2-9 
used with TN3270, 1-5, 2-5 

window size, 1-15 
Windows NT, 2-8 
Windows Open Systems Architecture 

(WOSA),1-7 
Windows for Workgroups, 2-6 
WinHLLAPI, 1-7 
Winsock 

client support, 1-6 
mainframe connectivity, 2-9 
used with TN3270, 1-5, 2-5 

Wollongong Pathway Access 
mainframe connectivity, 2-9 
used with TN3270, 2-5 

X 
X.2S, 1-4 





We Need Your Comments 
After you've used the product documentation, please give us your comments on this manual and the 
online help by completing this form and returning it to DCA. Your comments will help us improve 
our product. 

1 Which information do you use most? o Online o Printed 

2 Did you find any errors in the manual or online help? 

o Yes 0 No 
If so, please list the page numbers or online topic and describe the error: 

3 Did you look up a topic in the manual's index that you couldn't find? 

o Yes 0 No 
If so, please list the topic: 

4 Does the manual adequately explain how to install the product? 

o Yes oNo 
If not, what information is missing? 

5 What part of this manual do you use most? 

6 How often do you expect to refer to this manual? 

o Never o Once o Occasionally o Often 

7 Is the level of detail provided in the manual: 

o Too little o About right o Too much 
If not enough information, what information is missing? 

If too much information, what information do you not need? 

8 How do you look for information in a manual? 

o Scan the book o Refer to the Table of Contents o Look up topics in the index 

9 Does the manual adequately prepare you to use online help? 

o Yes oNo 



10 Are you able to move through the online help, leave the online help, and return to your starting 
point without problems? LI Yes LI No 

If not, what problem did you encounter? 

11 How would you compare DCA's online help to the online help you've used for 
other products? LI Poor LI Average LI Good LI Excellent 

Comments: __________________________________________________________ __ 

What online help have you used for other PC packages? 

12 Is the level of detail provided in the online help? 

LI Too little 
If not enough information, what information is missing? 

LI About right LI Too much 

If too much information, what information do you not need or want? 

13 Do you have any other comments about the overall quality of this documentation? 

Please tell us about yourself: 

Your name 

Company name 

Your title /key function 

Years of PC experience 

Address 

Country 

May we contact you about your comments? 

Please send your comments to: 

Irma for the Mainframe Getting Started 
Guide 032959 

2 Comrm:mts 

Phone 

LI Yes LlNo 

DCA 
Attn: Information Services 
1000 Alderman Drive 
Alpharetta, Georgia 30202-4199 
U.S.A. 



~lM 
3617 131st Ave. S.E. 
Bellevue, Washington 98006 
Printed in U.S.A. 


